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Chapter 1

About This Document

The Espressif Manual of Style is intended to promote established practices in Espressif documentation and help
Espressifers seeking advice on the topics related to documentation development.

1.1 Release Notes

1.1.1 Version 1.11 (Dec 2024)

• Added Chapter Admonitions

1.1.2 Version 1.10 (Dec 2024)

• Added Chapter Mathematical Expressions
• Updated SectionWhen to Use En Dashes and Section Time and Date Ranges to clarify which punctuation mark

should be used for indicating ranges

1.1.3 Version 1.9.1 (Aug 2024)

• Added Section Choosing Image Formats in Pictures and Diagrams
• Updated Section Alignment in Tables

1.1.4 Version 1.8.2 (May 2024)

• Added EMoS Quick Reference Guide and EMoS快速参考指南
• Added Section When Referring to Quantities in a List in Numbers

1.1.5 Version 1.8.1 (Feb 2024)

• Removed all links to internal resources
• Added a note in About This Document and homepage to explain the removal of internal links

1.1.6 Version 1.8 (Apr 2023)

• Updated Section Point of View
• Added Section Numeral Systems
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1.1.7 Version 1.7.4 (Oct 2022)

Updated Resources to add links to useful resources and documentation

1.1.8 Version 1.7.3 (Aug 2022)

• Updated three sections:
– Section Heading Titles
– Section Quotation Marks
– Section Cross-References in Chinese Text

• Added Section Software and Hardware Modes

1.1.9 Version 1.7.2 (May 2022)

• Updated Section Heading Titles and the notice in Section When to Use Hyphens

1.1.10 Version 1.7.1 (Apr 2022)

• Added links to EMoS Quick Reference Guide
• Updated three sections:

– Section When to Use Hyphens
– Section Rules of Using Commas
– Section FANBOYS Conjunctions

1.1.11 Version 1.7 (Jan 2022)

Added Chapter Writing Instructions

1.1.12 Version 1.6 (Sep 2021)

• Fixed typos and broken links
• Edited all the“V”standing for“version”to lowercase“v”
• Added two sections:

– Section When to Use Plus Signs
– Section On the Number of Verbs

• Added the example of“读/写”in Section General Rules
• Added the rule about when to add spaces around the ampersand“&”in Section General Rules
• Added the“RESTRICTED”watermark

1.1.13 Version 1.5 (Dec 2020)

• Updated Disclaimer and Copyright Notice
• Removed link to Espressif Product List

1.1.14 Version 1.4 (Aug 2020)

• Added Section Rules of Using Commas
• Updated links to templates in Chapter Pictures and Diagrams
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1.1.15 Version 1.3 (Mar 2020)

• Added new chapters:
– Chapter Time and Dates
– Chapter Tables
– Chapter Avoid Common Chinglish

• Updated Chapter Pictures and Diagrams
• Fixed some inconsistencies across chapters
• Updated the formatting of tables in accordance with the new chapter

1.1.16 Version 1.2 (Nov 2019)

Added Chapter Pictures and Diagrams

1.1.17 Version 1.1 (June 2019)

Updated links to Espressif Product Names and Espressif Term Base

1.1.18 Version 1.0 (May 2019)

Release 1
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Chapter 2

General Conventions

We would like our products to be easy to understand, attractive to use, and inspiring. We provide information about
these products in technical documentation like guides, manuals, datasheets, leaflets, test reports, and other technical
materials. To get our message across this documentation should be well structured, uniform, and easy-to-read. Also,
it should be consistent across products and product versions, so that customers are more likely to stay with us.
To promote consistent and attractive technical documentation, we are providing this guide which describes how text
should be organized, spelled, formatted, and so on. Not only will you find some rules here, but also ideas on how to
organize your text in a more optimal way. Feel free to try these ideas and check if it makes your text more attractive
or more appropriate to your audience. When doing so, you are welcome to share your opinion about how this guide
can be improved.

2.1 American or British Spelling

There are several areas in which British and American spelling are different. At Espressif, we follow American
spelling standards.

Table 1: Differences Between British and American Spelling
Difference American Spelling British Spelling
Words ending in -er or -re center centre
Words ending in -or or -our color colour
Words ending in -ize or -ise apologize apologize or apologise
Words ending in -yze or -yse analyze analyse
Words ending in -ense or -ence license licence

How to enable American spellcheck in word processors:
• When using MS Word, go to Review > Language, and then select (US) English.
• On Mac Pages go to Edit > Spelling and Grammar > Show Spelling and Grammar, and then

select U.S. English.
If you are not sure about how to spell a word, consult the Merriam-Webster’s Collegiate Dictionary.

2.2 Active vs. Passive Voice

In both English and Chinese technical writing, when writing manuals and user guides, we use active voice and try
to avoid passive voice except for rare instances. Active voice sentences are usually more engaging to the reader and
easier to understand.
When you start reading a sentence in the active voice, you can clearly identify who or what performs or should
perform a certain action (Press the Boot button to enter Upload mode), while passive voice sentences start with the
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action recipient (Upload mode is entered after pressing the Boot button) or the action itself (Entering Upload mode
is done by pressing the Boot button).
When you use the passive voice, a reader may have problems distinguishing between actions by the recipient and by
the user.
Example

Preferred Avoid
Press the EN button to reset the system. The system is reset by pressing the EN button.
按下 EN键使系统复位。 按下 EN键，系统被复位。

If a sentence in the active sounds like blaming the user, you can use the passive voice.
Example

Preferred Avoid
If the upload fails, the serial port name may have been
entered incorrectly.

If the upload fails, you may have entered an incorrect
serial port name.

上传失败可能是因为输入了错误的串口名称。 上传失败可能是因为你输入了错误的串口名称。

You can also retain the active voice by rewording the sentence to“If the upload fails, please check the serial port
name”.
Another situation when you might prefer the passive voice is to emphasize the action on the recipient or if the actor is
irrelevant or unknown. This is typically the case when writing test reports, where the reader is usually more concerned
with the test results rather than the party performing the testing.
Example

Preferred Avoid
All data was recorded in the quasi-peak and average
detection mode.

I have recorded all data in the quasi-peak and average
detection mode.

所有数据均以准峰值和平均检测模式记录。 我以准峰值和平均检测模式记录了所有数据。

In formal documents, like datasheets or specifications, the passive voice can be used more frequently.

2.3 Point of View

Point of view is the perspective a writer takes in writing documentation. It determines which pronoun to use.
In technical writing, writers generally write content from the reader’s (user’s) point of view or an impersonal point
of view depending on the content type. According to Diátaxis, technical documentation is classified into four major
types of content: tutorials, how-to guides, references, and explanations.
Content written from the reader’s point of view focuses on what the reader needs to do.
Content written from an impersonal point of view focuses more on“things”, such as what functions a module has
and how a component works with other components to achieve a specific function.

2.3.1 Use Second-Person Pronoun for Tutorials and How-to Guides

Write tutorials and how-to guides in second person.
Reasons

• Tutorials and how-to guides aim to teach readers how to complete a task. In second person, you write as though
you are speaking to the reader and the verb clearly denotes actions that they need to take, making it easier to
follow.
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• You promote a friendly tone and keep the reader more engaged with documentation.
Typical examples of tutorials and how-to guides among Espressif documentation are:

• ESP-IDF Programming Guide > Get Started, other contents that aim to help the reader to complete a specific
task

• TRM > Section Programming Procedure
• Development Board User Guide > Section Start Application Development

When writing procedural steps, combine the second person with an imperative mood and active voice. The imperative
mood makes your descriptions short and helps to eliminate the confusion around who or what performs specific
procedural actions.
In Chinese, use“你”instead of“您”. During translation, you do not have to translate each“you”or“your”
to“你”or“你的”. As long as the meaning is not affected, omit“你”or“你的”for fluent flow of the text.
Example
Differences between the“preferred”and“avoid”versions are highlighted in bold.

Preferred Avoid
To set up the ESP-IDF for your ESP32, do the fol-
lowing:

• Install Prerequisites
• Get ESP-IDF
• Set up the tools

These are the steps for setting up the ESP-IDF for
users’ESP32:

• Users install Prerequisites
• Users get ESP-IDF
• Tools should be set up

以下是为 ESP32设置 ESP-IDF的具体步骤：
• 安装准备
• 获取 ESP-IDF
• 设置工具

以下是为 ESP32设置 ESP-IDF的具体步骤：
• 用户准备安装
• 用户获取 ESP-IDF
• 用户设置工具

2.3.2 Use Impersonal Point of View for Explanations and Reference Materials

Write explanations and reference materials from an impersonal point of view.
Reason
When writing from an impersonal point of view, you describe from the perspective of a“thing”instead of a“person”
, such as what functions or features a module has and how a component work with other components to achieve a
specific function, instead of how readers interact with a component. References and explanations also focus on
describing“things”and usually do not need to address the reader.
Typical examples of references and explanations among Espressif documentation are:

• Chip and module datasheets
• TRM > Section Registers, Section Introduction
• ESP-IDF Programming Guide > Section API Reference, Section introduction for a component
• Product brief

Example
See Example 2 and 3 in Section Avoid“Users”and Third-Person Pronouns (They, She, He).

2.3.3 Avoid“Users”and Third-Person Pronouns (They, She, He)

Avoid addressing readers as“users”and“the user”when you can. Try to reword the sentence where any form of
“user”is used to address the reader.

Do not use gender-specific pronouns such as she, he, hers, and his.
Here are some examples to show how to reword sentences to avoid“user”.
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Example 1

Original Revision Note
Users can program data to the
eFuse memory by writing the
data to the programming regis-
ter and executing the program-
ming instruction.

To program data to the eFuse
memory, write the data to the
programming register first and
then execute the programming
instruction.

The example above intends to tell the reader
how to program data to the eFuse mem-
ory. Use of second person, combined with
imperative mood and active voice, makes
it obvious who will take what actions to
achieve what purpose.

Example 2

Original Revision Note
Users can use the hold
function for the pins to re-
tain the pin state.

The hold function can be
used to retain the pin
state.

This sentence is excepted from a paragraph dedicated
to describing the pin hold function, including what the
function is, how it works, and what it can achieve. So,
the sentence is intended to emphasize what the function
can do more than who can use that function. The revi-
sion uses passive voice to shift the focus from“users”
to the function itself.

Example 3

Original Revision Note
CPU will be reset immediately
when any type of reset above
occurs. Users can retrieve
reset source codes by reading
LP_CLKRST_RESET_CAUSE.

CPU will be reset imme-
diately when any type of
reset above occurs. The re-
set source code is stored in
LP_CLKRST_RESET_CAUSE.

The second sentence of this example is in-
tended to describe where to get the source
code. The revision introduces the word
“store”to connect“source code”and the

register where it is placed.

Exception
It is OK to use“the user”(instead of“users”) and refer back with the pronouns“they”in the following cases:

• When rewording makes your sentence long and hard to understand.
• When the target audience of your content is developers, it is OK to use“the user”to refer to people who use

the technology.

2.3.4 Use First-Person Singular Pronoun Sparingly (I)

In first person singular, you write as though you are speaking from the user’s point of view.
There are a small number of cases in Espressif’s documentation where use of the first-person singular pronoun is
acceptable:

• When writing a question in FAQs
• In product user interface (UI) to show someone’s control over an action in checkbox, button, or toggle labels
• When authors describe their opinions or actions in blogs or other documents

Example
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Example Note
I used ESP32 AT firmware to send Bluetooth LE scan command, but I
didn’t receive any scan response packet. Why?

This is an FAQ item written from the
user’s point of view.

I agree to the Terms of Use and Privacy Policy. This is displayed on the sign-up page
for a mobile application called Nova
Home.

First of all, you need to find a replacement for your current PHY chip.
I have a friend working for a semiconductors distribution company, so
I just picked up my phone and asked him for some advice.

This is from a blog in which the author
describes his experience of how to cre-
ate a new Ethernet PHY driver.

2.3.5 Use First-Person Plural Pronoun Sparingly (We)

In first-person plural, you write as though you are speaking to the reader from your company’s (Espressif) point of
view or you are standing by the reader’s side and making them feel that they are not alone.
There are a small number of cases in Espressif’s documentation where use of the first-person plural pronoun is
acceptable:

• Product Change Notification (PCN), Engineering Change Notification (ECN), advisory, etc. (to make clear
Espressif is the speaker)

• Blogs and books that help the reader learn something (to show that the reader is not alone)
Example

Example Note
We will evaluate software countermeasures along with their
performance impact.

This is from an advisory. The pronoun“we”
here represents Espressif.

我们将评估软件对策及其对性能的影响。
We are committed to offering solutions that are secure, robust
and power-efficient.

This is from Section About Us on espressif.com.
The pronoun“we”here represents Espressif.

我们致力于提供安全、稳定、节能的 AIoT解决方案。 In some cases, the pronoun can be omitted in
Chinese translation without affecting the mean-
ing.

In Section XX, the starting address of the first entry in the
partition table is 0x9000, rather than 0x0. Why? To answer
this question, we need to look at Figure 11-3 first.

This is from the ESP32-C3 IoT Project Devel-
opment Practice book. The pronoun“we”rep-
resent both the writer and the reader.

章节 XX节介绍了分区表的首个条目起始地址为 0x900
0，为什么不是 0x0这个地址呢？要回答这个问题，我们
首先看看图 11-3。

When using the first-person plural pronouns, be consistent throughout the content or document and make it clear who
the pronoun refers to.
Example

Original Revision Note
Firstly, we need to use “git
clone”to clone the TinyUSB
project. Since some TinyUSB
examples also require external
submodule libraries, you can
run the following command to
fetch them⋯

Firstly, use“git clone”to clone
the TinyUSB project. Since
some TinyUSB examples also
require external submodule li-
braries, run the following com-
mand to fetch them⋯

This example describes the prerequisites
for running TinyUSB application examples.
It is excerpted from ESP-IDF Program-
ming Guide. The original version is not
clear who the pronoun“we”refers to, the
writer, the ESP-IDF developers, the writer
and the reader, the company, or any other
combination? For another, switching be-
tween the first person and the second person
may make the reader confused.
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2.3.6 Avoid Switching Point of View Within a Single Content Type

Avoid switching personal pronouns (e.g., addressing the target audience as“you”and then as“they”) within a
single document or across the documents of the same type. There might be an exception to this rule if a document
consists of sections of different content types that require a different way of addressing described above.
A single document can contain more than one type of content. For example, in a TRM, Section Introduction is an
explanation, Section Programming Procedure is a how-to guide, and Section Registers is a reference. Therefore, it
might be not possible to keep consistency at the document level. In this case, try to keep consistency at a content
level.
Example

Original
To make report generation more convenient, users can define additional build targets in their projects such that
the report generation can be done with a single build command.
Add the following code to the CMakeLists.txt file of your project.
[code]
The following command can now be used :
[command]
Revision
To generate reports with a single build command, define additional build targets in your project.
Add the following code to the CMakeLists.txt file of your project.
[code]
Now, try the following command to generate a report:
[command]
Note
This example is intended to tell the reader how to generate reports with a single command for convenience. It is
a small how-to guide.
In the original version, switching between the second person and the third person may make the reader confused
about which action they should take.
In the revised version, second person is combined with imperative mood and active voice, making it obvious what
actions the reader should take to achieve what purpose.

2.3.7 Summary

The table below summarizes which point of view or pronoun can be used in a specific document (type). For detailed
guidelines, use scenarios, and examples, refer to SectionUse Second-Person Pronoun for Tutorials and How-to Guides
and Section Avoid Switching Point of View Within a Single Content Type.
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Document
(Type)

Second Per-
son

Impersonal Third Person First Person (I) First Person
(we)

Tutorials and
how-to guides1

Y

Explanations
and references2

Y

FAQ Y Y
UI Y Y
Blog Y Y Y
Documents
where you need
to make clear
Espressif is the
speaker

• PCN
• ECN
• ⋯

Y Y

Documents to
show you are by
the reader’s
side and make
them feel that
they are not
alone

• Blog
• Book
• ⋯

Y Y

Documents
whose target
audience is
developers, use
“the user”to

refer to people
who use the
technology

Y

Note that some Espressif documents are not listed in the above table. To determine which point of view or pronoun
to use in these documents, check if they belong to a particular document type in this table:

• If yes, use the point of view or pronoun suggested for this type of document.
• If no, check if the logic that these sections use to determine which pronoun to use can inspire you, or contact

Documentation Team for help.

1 Examples of tutorials and how-to guides include:
• ESP-IDF Programming Guide > Get Started, other contents that aim to help the reader to complete a specific task
• TRM > Programming Procedure
• Dev Board User Guide > Start Application Development

2 Examples of explanations and references include:
• Chip and module datasheets
• TRM > Section Registers, Section Introduction
• ESP-IDF Programming Guide > API Reference, introduction for a component
• Product brief
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2.4 Simplified or Traditional Chinese

We use simplified Chinese.

2.5 Define Abbreviations and Acronyms at First Use

Write out a full term for each abbreviation or acronym at its first use.
Example

• Mesh development framework (MDF), not Mesh Development Framework (MDF).
If a full term is given in a heading, provide it together with the abbreviation. If this makes the heading too long,
provide the abbreviation in the following text.
If an abbreviation or acronym is more familiar than the full term, then, probably, there is no need to write it out. You
can also follow this abbreviation or an acronym with the full term in parentheses, e.g., USB (universal serial bus).
If a document is very long, and people are supposed to use it as a reference guide, consider establishing a section
“Index of Abbreviations and Acronyms.”

2.6 If You Do Not Know How to Structure a Phrase

• Check in other documents that describe a similar concept.
• Look up similar phrases using refined web search techniques:

– Put the key parts of your phrase inside quotes, for example: “task scheduler”.
– Add “-”in front of a word you want to exclude from the search, for example: “task scheduler”-

Windows.
• Use synonyms of original words in your search phrase.
• Look for information in monolingual dictionaries (specific computer dictionaries). Here are a couple of ex-

amples:
– The Illustrated Dictionary of Electronics , published by McGraw-Hill
– Microsoft Computer Dictionary , published by Microsoft Press
– Oxford Dictionary of Computer Science , published by Oxford University Press

2.7 Heading Titles

In the paper and heading titles, capitalize the first letter of every word except for:
• Articles (a, an, the), unless the article is the first word in the title.
• Coordinating conjunctions (and, but, for, or, nor), unless the conjunction is the first word in the title.
• Prepositions of four letters or less; unless these prepositions are the first or last words. Prepositions of five

letters and above should be capitalized (Before, Through, Versus, Among, Under, Between, Without, etc.).
For hyphenated compounds in heading titles, always capitalize the first word, and capitalize any subsequent words
that are not articles, prepositions, or coordinating conjunctions.
Example

• High-Level Interrupts
• ESP8266 FOTA Demonstration with Phone App
• Demonstration Guide on Controlling ESP8266 Devices in IoT Cloud by Mobile Phone

Webpage titles are used to create a clickable table of contents that is often in the form of a menu on the left to navigate
the document structure. Make the titles descriptive and preferably fit them within one row of text.
In Chinese text, try to avoid putting English words at the beginning of Chinese titles or sentences. If there is no other
choice, do not capitalize the first letter.
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Example

Preferred Avoid
flash加密功能 Flash加密功能
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Chapter 3

Punctuation

First and foremost, use English punctuation in English writing and Chinese—full-width, double-byte—punctuation
in Chinese writing. Please do not use English punctuation marks in Chinese text and vice versa.

Table 1: Differences in Chinese and English Punctuation
Punctuation
Mark

En-
glish

Chi-
nese

Notes

Full stop (Pe-
riod)

. 。

Comma , ，
Enumeration
Comma

N/A 、 Chinese punctuation mark dividing listed items within a sentence. In English,
its role is fulfilled by a regular comma.

Colon : ：
Semicolon ; ；
Question
Mark

? ？

Exclamation
Mark

! ！

Quotation
Marks

“” “” The English and Chinese quotation marks might appear the same in this docu-
ment.

Quotation
Marks for
titles

N/A 《》 Chinese punctuation mark used to signify book titles, song titles, movie titles,
etc. For more details, see Section Cross-References in Chinese Text.

Parentheses ( ) （）
Tilde ~ ～ English tildes are used only for ranges that include negative numbers.

However, for texts where both English and Chinese writing is used side-by-side, please follow specific rules provided
in this chapter.

3.1 Spaces

3.1.1 General Rules

Use English spaces in the following cases:
• Between a number and the following unit of measure
• Between an English punctuation mark and the following English word

Example
• Powered by 40 nm technology, ESP32 provides a robust, highly integrated platform.
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When specifying a version number of a document or software application (v+number), do not add a space between
the lowercase“v”and the number.
Example

English Text Translated Text
Download the latest document (v1.0). 下载最新版本的文档 (v1.0)。

Do not use English spaces around hyphens, dashes, and slashes.
Example

Correct Incorrect
32-bit core 32 - bit core
AT+WPS—设置WPS功能 AT+WPS—设置WPS功能
On/Off switch On / Off switch
读/写 读 /写

Add English spaces before and after the ampersand for a combination of two independent names, but do not add
spaces around ampersand in abbreviations containing the word“and”. When referring to a company with an“&”
in its name, such as Marks & Spencer and AT&T, please check its official corporate website or other authoritative
source to confirm whether to add spaces in-between.
Example

Cor-
rect

Incor-
rect

Notes

Bei-
jing &
Shang-
hai

Bei-
jing&Shanghai

Note that in official technical documentation, it is strongly recommended to avoid using
“&”to indicate the meaning of“and”. Such expression is only acceptable in informal

texts or when there is only limited space.

R&D R & D

Note:
Please pay special attention to spaces in code or commands. For example:

• There must not be any spaces in the following AT command: AT+UART=115200,8,1,0,3.
• However, there must be a space in the following terminal command: make flash.

3.1.2 Mixing Chinese Writing with Numbers and English Writing

In Chinese texts with English inserts, only use English spaces:
• Between Chinese characters and English letters
• Between Chinese characters and English punctuation marks
• Between Chinese characters and numbers

Example
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English Text Translated Text Notes
ESP32 integrates Wi-Fi (2.4 GHz band) and
Bluetooth 4.2 solutions on a single chip.

ESP32是集成 2.4 GHz Wi-Fi和蓝牙 4.2的
单芯片方案。
关于 ESP-IDF的基本使用，可参考目录下
的 README (.md)文件。

See Section
Parentheses.

乐鑫 (Espressif)是一家无晶圆厂半导体公
司。

See Section
Parentheses.

乐鑫研发和设计 IoT业内集成度高、性能
稳定、功耗低的无线系统级芯片。

But never use English spaces around Chinese punctuation marks.
Example

Chinese Text Notes
ESP-WROOM-32模组（内置了
ESP32芯片）

See Section Parentheses.

乐鑫总部位于中国上海 (Shang-
hai, China)，是一家无晶圆厂半
导体公司。

See Section Parentheses. Here, there is an English space before the left
parenthesis, but no space after the right parenthesis as it is followed by a
Chinese punctuation mark.

3.2 Parentheses

If the text enclosed in the parentheses only consists of English letters and/or numbers:
• Use English parentheses.
• Separate the text outside of English parentheses with one English space. See Section Mixing Chinese Writing
with Numbers and English Writing.

Example
• 关于 ESP-IDF的基本使用，可参目录下的 README (.md)文件。

If the text enclosed in the parentheses consists of Chinese characters or, among English letters and/or numbers,
includes Chinese characters:

• Use Chinese parentheses.
• Do not add spaces between Chinese parentheses and the text outside of them.

Example
• ESP32集成了Wi-Fi（2.4 GHz带宽）和蓝牙 4.2。
• 准备一台 PC（安装Windows操作系统）

3.3 Hyphens and Dashes

Table 2: Hyphens and Dashes
Name Symbol Keyboard Shortcut

Windows Linux macOS LaTeX
Hyphen - - - - -
En dash – – – Option + - Option + -
Em dash — — — Shift + Option + - —
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3.3.1 When to Use Hyphens

This section introduces some common cases where hyphenation is needed.
Use hyphens in a compound modifier preceding the modified word. A compound modifier is a string of two or
more words that function together as an adjective and cannot be separated. Hyphenation in this case aids clarity and
readability.
Example

Compound Modifier (Preceding a Noun) Predicative Expression (Part of a Verb Phrase)
We are using state-of-the-art technology. The technology we use is state of the art.
The company develops Wi-Fi-enabled toys. The toys the company develops are Wi-Fi enabled.

Hyphenate compound modifiers preceding nouns in the following cases:
• The modifier consists of a noun or adjective and a present or past participle.
Example

Preferred Avoid
small-sized development board small sized development board
Wi-Fi-enabled toy Wi-Fi enabled toy

• The modifier consists of a number, single letter, or fraction and a noun or participle.
Example

Preferred Avoid
2-bit data length 2 bit data length
y-coordinate value y coordinate value
half-duplex mode half duplex mode

• Confusion might occur without the hyphen.
Example

Preferred Avoid
built-in operating system built in operating system
on -board PCB antenna on board PCB antenna
state-of-the-art technology state of the art technology

Do not hyphenate in the following cases:
• Do not hyphenate a predicative adjective modifying the subject of a sentence that follows a verb unless it is an

established hyphenated compound.
Example

Preferred Avoid Note
The camera is built in. The camera is built-in.
The module is small sized. The module is small-sized.
It determines whether individ-
ual eFuse parameters are write-
protected.

It determines whether individual
eFuse parameters are write pro-
tected.

Write-protected is an estab-
lished term widely used in the
industry.

• Do not use hyphens when the words preceding nouns do not function collectively as a compound modifier.
In such cases, the words before a noun can be separated and function independently. For example, when the
modifiers consist of an adverb and an adjective where the adverb modifies the adjective. In such cases, the
modifier may start with the word“very”or other adverbs ending in“ly”.

• Do not use hyphens between different units of modifier that modify the same noun.
Example
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Preferred Avoid Note
high-level pro-
gramming lan-
guage

high-level-
programming
language

thirty-two 32-bit
general-purpose
registers

thirty-two 32-bit-
general-purpose
registers

It is suggested to avoid using consecutive compound modifiers
for better readability and only use them where white space is
at a premium.

• Do not add hyphens between the noun and its modifier.
Example

Preferred Avoid
in Station mode in Station-mode
Light-sleep mode Light-sleep-mode

• Do not form hyphenated modifiers from one-word adjectives. If you are not sure whether the word is a one-
word adjective, refer to Merriam-Webster’s Collegiate Dictionary or go to Documentation Team Site > Section
Something You Might Find Useful > Espressif Term Base. You can also consult Documentation team
members.
Example

Preferred Avoid
uppercase and lowercase letters upper-case and lower-case letters

• Do not hyphenate a compound modifier that includes an open compound. Instead, use an en dash.
Example

Preferred Avoid
Windows 10–compatible products Windows 10-compatible products

The above examples may not cover all situations. If you are not sure whether the hyphenation is needed, always
refer to Documentation Team Site > Section Something You Might Find Useful > Espressif Term Base and
authorized dictionaries such as Merriam-Webster’s Collegiate Dictionary, or consult Documentation team members.
When using a suspended compound modifier, include a hyphen with both adjectives and follow the first hyphen with
a space.
Example

Preferred Avoid
upper- or lower-right corner upper or lower-right corner
in a byte-, half-word-, or word-aligned manner in a byte, half-word, or word-aligned manner

Note: When the hyphenated words need to be capitalized, e.g., if it is included in a heading title, capitalize the first
word and any subsequent words that are not articles, prepositions, or coordinating conjunctions. For example, use
Read-Only Mode in a heading instead of Read-only Mode.

3.3.2 When to Use En Dashes

• To indicate a minus sign (for example,“1–2”)
Exception
Use hyphens when writing code.

• To indicate negative numbers, for example,“–1”
• To contrast values, or illustrate a relationship between two things, for example,“Pycom–EspressifHackathon”
• To connect words in a compound modifier that includes an open compound
Example
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– Windows 10–compatible products
• To indicate a range of values in English documentation, without spaces before and after unless there is a

measurement unit before it
Example

Preferred Avoid
GPIO21–GPIO23 GPIO21 –GPIO23
pp. 38–55 pp. 38 –55
2.3 V –3.6 V 2.3 V–3.6 V

However, for ranges that include negative numbers, a tilde (~) may also be used to avoid ambiguity or awk-
wardness (e.g., a temperature range of −40 °C ~ +85 °C).

Note: In Chinese documentation, use tildes instead of en dashes to indicate ranges. Spaces are not needed
before and after the tilde unless there is a measurement unit before it (e.g., 2.3 V～3.6 V).

Note: Do not use tildes to represent the word“about”.
Example

Preferred Avoid
The drive strength of the internal pull-up (wpu) and
pull-down (wpd) is about 75 μA.

The drive strength of the internal pull-up (wpu)
and pull-down (wpd) is ~75 μA.

See also Section Time and Date Ranges.

3.3.3 When to Use Em Dashes

Use an em dash to denote a break in a sentence or to set off parenthetical statements.
Example

• The information in your spreadsheet—numbers, formulas, and text—is stored in cells.

3.4 Slashes

The word slash usually implies the forward slash”/”which is used in writing and computer coding. However, there
is also the backslash”\”which is used in computer coding only.
Use a slash character in the following cases:

• In constructions that imply a combination
– I/O pad
– read/write operation

• For fractions
– 1/3

• As a separator for compound units of measure
– 100 Mbit/s

• As the path separator in OS Linux and other Unix systems
– cd ~/esp/hello_world

• For website URLs
– See https://www.espressif.com/

Use a backslash character in the following cases:
• As the path separator in MS Windows

– cd C:\Users\%userprofile%\esp\hello_world

Do not use slashes in the following cases:
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• A substitute for“or”
Example

Preferred Avoid Notes
Some embedded memories can be ac-
cessed via the data bus or the instruc-
tion bus.

Some embedded memories can be
accessed via the data/instruction
bus.

Not clear if the slash mark
indicates“or”or“and”
.

3.5 Quotation Marks

Differentiate between single quotation marks and double quotation marks.
In English, divide a quote from the surrounding text with double quotes. If you add a quotation within an already
quoted text, use single quotation marks. This concept can be represented as“⋯‘⋯’⋯”.
If the text enclosed in quotation marks only consists of English letters and/or numbers:

• Use English quotation marks.
• Separate the text outside of English quotation marks with one English space. See Section Mixing Chinese
Writing with Numbers and English Writing.
Example

– 如果引导加载程序二进制文件过大，则引导加载程序构建将失败并显示“Bootloader binary size
[..] is too large for partition table offset”的错误。

Please note the text here is no UI element. For UI elements, see Chapter Writing Instructions.
If the text enclosed in quotation marks consists of Chinese characters or, among English letters and/or numbers,
includes Chinese characters:

• Use Chinese quotation marks.
• Do not add spaces between Chinese quotation marks and the text outside of them.

3.6 Brackets

3.6.1 Square Brackets

Use square brackets as follows:
• Within parenthetic text . Use square brackets when nested parentheses are needed.

– （不能是简单 Type [如 string或 Guid]）
• For optional command-line entries . Use to indicate an optional parameter or other types of entries.

– idf.py -p PORT [-b BAUD] flash

Do not put spaces between brackets and the text that these brackets enclose, for example, [Module Name].

3.6.2 Angle Brackets

Use angle brackets and lowercase letters for tags, for example, the <h1> tag, the <font> tag.
You can use a right-angle bracket“>”to show navigation in menus. Put a space before and after the bracket.
Example

• Click File > Export To > PDF.
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3.7 Punctuation in Lists

The following notes on punctuation in lists should be made:
• Place a colon“:”at the end of an introductory phrase.
• Use a full stop at the end of each item in a list of complete sentences, such as this one.
• Omit punctuation at the end of each item in a list of sentence fragments.
• If a list has at least one complete sentence, use a full stop at the end of each item, regardless of whether it is a

fragment or a full sentence.
Here is an example of a list consisting of sentence fragments. Its characteristic features are as follows:

• Short items
• Absence of active verbs
• Abundance of Participial phrases

Use the following capitalization rules:
• Capitalize the first letter of each item in a list of complete sentences.
• Preferably capitalize the first letter of each item in a list of sentence fragments.
• In a list of single words, preferably do not capitalize the first letter of each item.
• If at least one item in a list is capitalized, capitalize all the other items.

3.8 Rules of Using Commas

Punctuation plays an indispensable role in conveying information clearly and concisely. In particular, missing or
misplaced commas may introduce a lot of confusion in sentences.
In some cases, the need to add a comma is self-evident. In other cases, there is some degree of flexibility in how to
use commas. Yet in other cases, you need to have a clear grasp of some rules.
The guidelines below will help you brush up on how to properly use commas.
Cases in which you SHOULD use commas:
1. Separating items in a series of three or more nouns or two or more coordinate adjectives.

Example
• It helps meet the continuous demands for efficient power usage, compact design, security, high

performance, and reliability.
It is recommended that you use the serial comma before the final“and”or“or”in the list of several items. This
kind of serial comma is usually called the Oxford comma. Whether or not you decide to use it, please be consistent.
Keep in mind, however, that there are cases in which the Oxford comma might affect the meaning –please refer to
Section Intricacies of Using the Oxford Comma.
2. Surrounding nonessential appositives (those that add information to a sentence but can be omitted without changing
its meaning).

Example
• The module can be completely independent, which means it does not rely on the implementation

of other modules.
3. Before a coordinating conjunction (e.g., and/but/so/yet/nor/for).

Example
• The function will be used repeatedly in the module, so it is reasonable to add this function to the

design.
But you do not need a comma if both independent clauses are relatively short and similar in meaning.
Example

• Try them out and see the diagram instantly rendering below.
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4. After introductory elements.
Example

• On top of that, we have created a couple of custom add-ons and extensions to help integrate doc-
umentation in the ESP-IDF repository.

5. After the abbreviations i.e. (which means“that is”or“in other words”) and e.g. (which means“for example”
).

Example
• After it starts up, the timer can generate a specific event, e.g., the Alarm Event.
• The code coverage data is stored internally on the target (i.e., in trace memory).

6. In a complex sentence, use a comma to separate a dependent clause that comes BEFORE an independent clause.
Example

• If you want to use these features, you need to ensure that ESP32 supports them.
Essentially, the main function of a comma is to add a pause. There is a simple trick to test the placement of commas.
Whenever you write something, read it aloud as it is written, then read it aloud as you intend it to sound. If you find
any inconsistencies, you might need to add or remove some commas to introduces the required pauses or to emphasize
important parts.

3.9 Intricacies of Using the Oxford Comma

The Oxford comma is a comma that is used before the conjunction that joins the last two enumerated items within
a sentence. The Oxford comma helps to prevent confusion with regard to whether the last two items in a series are
related.
Example

Preferred Avoid Notes
The table should
provide separate
columns for user
IDs, their first
names, and last
names.

The table should
provide separate
columns for user
IDs, their first names
and last names.

The phrase their first names and last names does not make it clear
whether first names and last names should be placed in one column
or in separate columns. Adding the Oxford comma before and,
disambiguates the situation. Now it is clear that you need two
separate columns.
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Chapter 4

Numbers

This chapter summarizes some of the widely applicable guidelines for handling numbers in technical context. In
financial, marketing and other contexts where the guidelines may not be applicable, editorial judgment must be used
to preserve clarity, precision, logic, and readability within any particular document.

4.1 Arabic Numerals Versus Spell-Out

4.1.1 When to Use Arabic Numerals

Table 1: When to Use Arabic Numerals
When to Use Arabic Numerals Example Comment
When a single-digit whole number
is used as an adjective

8-digit code

For 10 and greater whole numbers ESP8266 has 17 GPIO pins. For large numbers that are not ex-
pressed with high precision, the text
form may be a combination of nu-
merals and words, e.g., 7 billion
people.

For 2-digit ordinals and larger 2nd, 10th
Measurements • 1 byte

• 2.4 GHz
• 3 V
• 5 grams

This is true whether the measure-
ment is spelled out, abbreviated, or
replaced by a symbol.

To express dates, the time of
day, pages, chapters, figures, steps,
notes, and numbered items in doc-
uments

• April 8
• 09:30
• Chapter 2
• Table 2-1
• Step 1

This rule does not apply to expres-
sions with hours, days, weeks, or
other units of time. Example: 24
hours, two days, three years

Percentages 90% duty cycle
When used as input Type 1, and then press Enter.
When representing parameter val-
ues

The default value of this register is
0.
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4.1.2 When to Spell Out Numbers

Table 2: When to Spell Out Numbers
When to Spell
out Numerals

Example Comment

Single-digit
whole numbers

ESP32 has three UART
controllers.

While begin-
ning a sentence
with a number

Eighteen pads have low
power capabilities and
analog functions.

It is better to reword the sentence so that the number comes later.
Example: Out of the 40 physical GPIO pads, 18 pads have low
power capabilities and analog functions.

Fractions one-third
Single-digit or-
dinal numbers

first, second

Maintain consistency among categories of information; that is, if one number in a category requires a numeral, use
numerals for all numbers in that category.
Example

Preferred Avoid
ESP32-S2 has 1 LCD interface, 2 UART interfaces,
and 43 GPIO interfaces.

ESP32-S2 has one LCD interface, two UART interfaces,
and 43 GPIO interfaces.

When two numbers that refer to separate categories must appear together, spell out one of them.
Example

Preferred Avoid
two 8-bit D/A converters 2 8-bit D/A converters

4.2 10,000 and Greater Numbers

Use a comma“,”to mark off groups of three digits for numbers of five digits or more.
Example

• 10,240 bytes
• 10,000 B.C.

Exception
• Do not use commas in page numbers, addresses, and decimal fractions.

Example
• page 10011
• Pune-411045
• 3.14159

4.3 When Referring to Quantities in a List

In the English version, omit the prefix‘1 x’when an item is in a single quantity, opting to simply name the item.
For multiple quantities:

• Spell out numbers for single-digit whole numbers.
• Use Arabic numerals for 10 and greater whole numbers.
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Example

Prefferred Avoid

• 12-bit SAR ADC
• Two temperature sensors
• 12 GPIOs

• 1 x 12-bit SAR ADC
• 2 x temperature sensors
• 12 x GPIOs or Twelve GPIOs

In the Chinese version, omit the prefix‘1 x’when an item is in a single quantity, opting to simply name the item.
For multiple quantities, use Arabic numerals for all numbers.
Example

Prefferred Avoid

• 12位 SAR ADC
• 3个 UART

• 1 x 12-bit SAR ADC
• 3 x UART或三个 UART

4.4 Numeric Ranges, Dimensions, Series, and Placement of Units

A range of numbers and the accompanying unit can be expressed with a single unit symbol after the second number
of the range, except when the symbol cannot be separated from the number (e.g.,“%”symbol). Alternatively, the
unit symbol may follow both numbers of the range. Whichever style is selected, use it consistently.
Example

Correct Incorrect
23 to 47 kV
23 kV to 47 kV
10% to 15% 10 to 15%

If a range begins a sentence, spell out the first number and write the second as a numeral, or recast the sentence.
Generally, any accompanying units will appear only after the second number and may be abbreviated. If the unit
must also appear after the first number (as for“%”symbol), then write out both units or recast the sentence.
Example

Correct Incorrect Comment
Eighty to 240 MHz of fre-
quency is available for the
CPU clock.

80 to 240 MHz of fre-
quency is available for the
CPU clock.

It would be better to recast the sentence into“CPU
clock frequency is adjustable from 80 MHz to 240
MHz”.

For dimensions, use a multiplication symbol (not a small letter“x”) or the word“by”to separate the measurements.
Example

• 10 × 55 × 5 mm or 10 mm × 55 mm × 5 mm
For a series of numbers, place the unit after the last numeral only, except when the unit symbol cannot be separated
from the number.
Example

Correct Incorrect
12, 17, 43, and 66 kV
diameters of 5 and 9 mm
15%, 22%, or 31% 15, 22, or 31%
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For more information on using units of measure and unit symbols, please refer to Chapter Measurement Units and
Abbreviations.

4.5 When Referring to Money

4.5.1 Currency Sign vs. Currency Code

It is recommended that currency amounts are expressed in accordance with the International Organization for Stan-
dardization (ISO) currency codes, instead of currency signs. Currency codes are specific to a currency, and cannot be
confused or misinterpreted by the reader. Currency symbols such as the dollar sign ($) are not unique and are easily
misread.
Example

Preferred Avoid
The ESP32-DevKitC is priced at 55 CNY. The ESP32-DevKitC is priced at ¥55.

The following table shows examples of currency codes.

Table 3: Examples of Currency Codes
Currency Code
yuan renminbi CNY
U.S. dollar USD
Canadian dollar CAD
Hong Kong dollar HKD
euro EUR
pound sterling GBP
Swiss franc CHF
yen JPY

If you do need to use a currency sign, place it before the figure: ¥300, £100, etc. Always make clear to what currency
you are referring.

4.5.2 Abbreviations

Avoid using abbreviations (e.g., m, M, MM for millions, K for thousands), when referring to money in technical
context. In financial or other contexts, please consult department-specific guidelines.

4.6 Fractions and Decimals

• Hyphenate spelled-out fractions used as adjectives or nouns.
Example

– One-third of the book
– Two-thirds completed

• Write decimals with a period (full stop), not a comma: 0.75, 6.4.
• When units of measure are not abbreviated, use the singular for quantities of one or less, except for zero, which

takes the plural.
Example

– 0.5 inch
– 0 inches
– 5 inches
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4.7 Phone Numbers

It is recommended that telephone numbers follow the International Telecommunication Union (ITU) standard: ITU-
TE.123.
International telephone numbers begin with the plus sign followed immediately by the country code, then by the area
code, and the number.
Example

• You can reach Espressif by calling +86 021 6### ####.
The leading plus (+) signifies the international prefix. Spaces are used to visually separate groups of numbers.
National telephone numbers begin with area code included in parentheses followed by the number.
Example

• You can reach Espressif by calling (021) 6### ####.
The parentheses indicate that the area code is not always dialed and they should not be used in an international number.
For better readability, please use non-breaking spaces to keep telephone numbers on the same line. If a telephone
number is close to the end of the line, you get +86 021 6### ####. The number is treated as one word.

4.8 Addresses (Mailing)

Mailing addresses may have different standard formats in different places. Please follow the mailing address formats
when writing Espressif corporate addresses.
Espressif China Office Mailing Address Format in Chinese

Address Elements Description
上海浦东新区张江高科 [province, city, district]
碧波路 690号 2号楼 101室 [street name with street number, building name or number, room num-

ber]
乐鑫信息科技（上海）股份有限公
司

[company name]

邮编 201203 [postal code]

Espressif China Mailing Address Format in English

Address Elements Description
Espressif Systems (Shanghai) Co., Ltd. [company name]
Suite 101, Block 2, 690 Bibo Road [room number, building name or number, street name]
Zhangjiang High-Tech Park, Pudong [district, city]
Shanghai, China 201203 [province, country, postal code]

Espressif Czech Republic Office Mailing Address Format

Address Elements Description
Espressif Systems (Czech) s.r.o. [company name]
Holandská 878/2 [street name + block number and/or building number]
639 00 Brno-Štýrˇice [postal code + city name]
Czech Republic [country]

Espressif India Office Mailing Address Format
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Address Elements Description
Espressif Systems (India) Private Limited [company name]
G-1, Eco Tower [flat number, building name]
Baner-Pashan Link Road [street number, street name]
Baner [locality or neighborhood]
Pune-411045 [city, postal code]
Maharashtra, India [country]

4.9 Numbers in Chinese Text

If Arabic numerals are used in English text, please use Arabic numerals in the translated text. If English words are
used in English text, please use Chinese words in the translated text.
Example

English Translated Text Notes
20 mm 20 mm
7 billion people 70亿人口
10% 10%
10 percent 百分之十 For percentages, don’t mix numbers and words, e.g.,百分之 10.
one-third 三分之一

4.10 When Referring to Numbers in Examples or Interfaces

Represent numbers taken from examples or the user interface exactly as they appear in the example or the user
interface.
Example (see Figure below)

Preferred Avoid
See 123-45-678, as shown in the interface below. See 123 45 678, as shown in the interface below.

Fig. 1: Example for Representation of Numbers
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4.11 When to Use Plus Signs

The plus sign“+”is usually used to indicate that two or more numbers should be added together, or to indicate a
positive number such as +85 °C。
In some cases, it is also used to indicate“over”or“more than”when placed after a number. However, it is strongly
recommended to avoid such expression and use “>”, “more than”or other to express the meaning in formal
technical writing and official documentation.
Example :

Preferred Avoid
The soldering time should be more than 30 s. The soldering time should be 30+ s.

Use plus signs to indicate“more than”only:
• In informal texts
• When there is only limited space and conciseness appears to be most important

4.12 Numeral Systems

A numeral system is a writing system for expressing numbers. In general, we recommend decimal and hexadecimal
numbers.

• When describing large numbers relevant to software development or system design, for example, in program-
ming guides or register descriptions, please use hexadecimal numbers. They provide a human-friendly repre-
sentation of binary-coded values, and are less prone to errors as they represent large numbers with fewer digits.
Please add“0x”to the beginning of hexadecimal values.
Example

– If the pin level of ADDR is low, then the address is 0x23, otherwise it is 0x5C. Configure the field
EFUSE_OP_CODE of register EFUSE_CONF_REG to 0x5A5A.

• When describing quantities, measurements, money, time, etc., please use decimal numbers.
• Do not use Verilog number format in the above cases, e.g., 1’b1 or 1’h0 in register descriptions. This is not

easy to read and may lead to mixed use of different numeral systems.
Example

Preferred Avoid
1 1’b1
0 1’h0
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Chapter 5

Time and Dates

This chapter provides general guidance on the expressions of time and dates. The first and the second sections cover
time and dates respectively, the third section is about how to write time and date ranges, the fourth section provides
guidance on abbreviating the related terms, the fifth section provides general rules for writing time and dates in
Chinese, and the last section covers additional guidelines.

5.1 Time

5.1.1 24-Hour System or 12-Hour System

Two systems are used to designate the hour of the day: 12-hour system and 24-hour system.
The 24-hour system is used by international standard ISO 8601. To accommodate the worldwide audience, Espressif
recommends using the 24-hour time notation whenever you can.
Example

• The meeting is set to 14:00 Beijing Time.
If you must use the 12-hour system, add the abbreviations AM (ante meridiem [i.e., before noon]) and PM (post
meridiem [i.e., after noon]) to the end of the clock time.
Example

• 6 AM = 6 o’clock in the morning
• 10 PM = 10 o’clock in the evening

The abbreviations am and pm, a.m. and p.m., A.M. and P.M., are also acceptable.

5.1.2 Separator Symbols

Use a colon to separate hours, minutes, and seconds.
Example

• 23:59:59.5 = 0.5 s before midnight

5.1.3 Expressing Noon or Midnight

Just using“noon”or“midnight”is sufficient to indicate noon or midnight.
Example
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Preferred Avoid Comment
The meeting is at noon. The meeting is at 12 PM. 12 PM is ambiguous.

5.1.4 Time Zone

The time in China follows a single standard time offset of UTC+08:00 (eight hours ahead of Coordinated Universal
Time). The official national standard time is called Beijing Time (Chinese: 北京时间) domestically and China
Standard Time (CST) internationally.
If you give time for an event that involves audience from different time zones, include the time zone and the offset
from Coordinated Universal Time (UTC).
Example

• The roadshow begins at 10:00 China Standard Time (UTC+8).

5.2 Dates

5.2.1 Writing Dates with the Month

• Capitalize the names of the months, e.g., January.
• Spelling out the names of months is recommended. When short forms are needed in tables, graphs, and other

locations, use their three-letter abbreviations without dots, e.g., Apr, May.
• Using ordinal numbers to indicate a date is NOT recommended, e.g., May 13th.

5.2.2 Writing Dates with the Month and the Year

• When referring to a specific date with the month and the year, use the format“month day, year”(e.g., July
31, 2010). Place a comma before and after the year if it is not at the end of a sentence.
Example
– On July 22, 2019, Espressif went IPO.

Note that a comma is used to set off the year in exact date. If there is no exact date, no comma is used. e.g.,
In July 2019, Espressif went IPO.

• There may be times when it is appropriate to use other date formats besides the recommended“month day,
year”style. For instance, “day/month/year”(e.g., 11/Nov/2018) may be used in Excel. When you use a
certain date style, make sure that it is human readable and consistent across the document. Avoid using any
formats that produce ambiguities or hinder comprehension. Below is a list of acceptable date formats:

Table 1: Acceptable Date Formats
Acceptable Date Format Example Comment
day month year – 11 November 2018

– 11/November/2018
– 11-November-2018

Do not truncate the year to
two digits unless space is re-
stricted.

year month day 2002 April 23
[year][month][day] all-numeral style – 20180801

– 2018-08-01

• The following formats are NOT acceptable to indicate a date:
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Table 2: Non-acceptable Date Formats
Not Acceptable Date Format Example Comment
[day]/[month]/[year] all-numeral style 01/02/2017 01/02/2017 can be inter-

preted as February 1, 2017,
or as Jan 2, 2017.[month]/[day]/[year] all-numeral style 01/02/2017

5.2.3 Writing Days of the Week

• Capitalize the names of the days of the week, e.g., Monday.
• Spelling out the days of the week is recommended. When short forms are needed in tables, graphs, and other

locations, use their three-letter abbreviations without dots, e.g., Mon, Tue.
• When giving a date with both days of the week and month or year, use a comma after days of the week to

ensure readability.
Example

– The meeting planned for Monday, February 24, 2020, has been postponed.
• Avoid referring to week by week number of the year. Instead use specific date when the week starts.
Example

– Testing will be done during the week of February 24, 2020.
• According to the International standard ISO 8601, Monday is the first day of the week and Sunday the last day

of the week.

5.3 Time and Date Ranges

Use the en dash to indicate a time or date range, without spaces before and after, e.g., 11:00–13:00, July 29–July 31,
2008–present. The en dash indicates up to and including, or through.
Optionally, use“from”(followed by“to”) or“between”(followed by“and”) to indicate a period of time,
e.g., from 11:00 to 13:00, between midnight and 2:00, between 2018 and 2020.
But do not mix the en dash with words e.g., do not use: from 11:00–13:00, between 2018–2020.
See also Section When to Use En Dashes.

5.4 Acronyms and Abbreviations

The following acronyms and abbreviations to indicate time are either recognized in the International System of Units
(SI) or acceptable in various kinds of literature:
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Table 3: Acronyms and Abbreviations for Time and Dates
Acronyms andAbbreviations Definition Example
24/7 24 hours a day, 7 days a week

year(s)
A 24/7 support program

Y or yr. year(s) 12Y = 12 years = 12 yrs.
mo. month(s) 3 mos. = 3 months
d or d. day(s) 5 d = 5 days
h or hr. hour(s) 27 h = 27 hours = 27 hrs.
min or min. minute(s) 30 min = 30 minutes = 30 mins.
s or sec. second(s) 4 s = 4 seconds = 4 secs.
Days of the Week
Sun Sunday –
Mon Monday –
Tue Tuesday –
Wed Wednesday –
Thu Thursday –
Fri Friday –
Sat Saturday –
Months
Jan January –
Feb February –
Mar March –
Apr April –
May May –
Jun June –
Jul July –
Aug August –
Sep September –
Oct October –
Nov November –
Dec December –

• If the numeric value involves only one unit of time, insert a space between the number and symbol. If the value
calls for more than one unit, set the numbers and symbols close.
Example

– 3.3 h
– 3h20min
– 3h20min14.6s

• Use the acronyms and abbreviations for time cautiously. They may mean different things in different context.
For example, “Y”is also the abbreviation for measurement unit “yotta”. Avoid using any acronyms or
abbreviations that produce ambiguities or comprise comprehension.

5.5 Time and Dates in Chinese

• Both 12-hour and 24-hour clock formats are used in Chinese context. For example, 11:00 =上午 11:00, 17:30
=下午 5:30, 21:00 =晚上 9点.

• The normal form of days of the week is星期几, e.g.,星期一. The abbreviation for days of the week is周几,
e.g.,周一.

• The full form of the names of months in Chinese uses characters, e.g., 一月. The abbreviated form uses
numerals, e.g., 1月.

• The default long date format in Chinese is YYYY年MM月DD日 or YYYY年M月D日, e.g., 2020年 02
月 02日 or 2020年 2月 2日. The default short date format in Chinese is YYYY/MM/DD or YYYY/M/D,
e.g., 2020/02/02 or 2020/2/2.
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5.6 Additional Guidelines

Be specific if using months or years when exact dates or periods are important.
Example

Preferred Avoid Comment
Beta version of software will
be released at the end of May
2020.

Beta version of software will be
released in May 2020.

With the“Avoid”version user will expect
to have the software at the beginning of
May while developer really meant the end
of May.
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Chapter 6

Mathematical Expressions

This chapter clarifies a unified style to render mathematical symbols and formula in Espressif documentation. It
covers key components of mathematical expressions, along with conventions on spacing, font, typesetting and citing
formulas.

6.1 Key Components

Mathematical expressions often involve various components such as variables, constants, operators, and formulas etc.
Here is an overview of the key components in mathematical expressions.

Table 1: Key Components
Components Definition Example
Variable A symbol (often a letter) represent-

ing quantity that can change or vary. • x (could denote position)
• t (might represent time)

Constant A symbol that has a fixed value. • π = 3.14159
• e = 2.718

Physical Quantity A product of a numerical value (a
pure number) and a unit. • length

• mass

Operator A symbol that represents a mathe-
matical operation.

±, =, ∩, ∫, Π, Σ

Enclosing Mark A pair of symbols that control the
order of operations. • parentheses

• brackets
• braces

Formula An expression that calculates a spe-
cific value or relationship between
variables.

• A = r2

•

UART_CLKDIV +
UART_CLKDIV_FRAG

16

Equation A mathematical expression that
contains the“=”.

f(x) = y

Inequality A mathematical expression where
we compare two expressions that
are not equal by using the symbols
such as < > = ≥ ≤ ≠.

x < 1
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Note: Define all symbols for mathematical constants, variables, and unknown quantities the first time you use them.
Do not define standard mathematical constants such as“π”,“i”, and“e”.

6.2 Spacing

The general consideration is good mathematical spacing helps to indicate grouping: Things that are more closely
related should be set more tightly than things that are less closely related. Please see the following spacing convention
with examples.

• Leave a space
– before and after mathematical signs used as operators (=, ≠, ≈, ≅, >, <, +, –, ×, ÷, etc., but not slash,

ratio colon, or centered dot), except when they appear in superscripts or subscripts
Example
LEDC_CLK_DIV = A+ B

256
– before and after trigonometric
Example
4 sin θ
Leave a space before and after sin.

– before and after functions that are set in roman type when their arguments are not in enclosing marks
Example
1 + log y
Leave a space before and after log.

• Leave no space
– between single-item variables being multiplied
Example
xy

– in any part of a superscript or subscript, unless confusion or misreading would result
Example
Eλ>353

Leave no space before and after >.
– between any character and its own superscript, prime, or subscript
Example
xa+b

Leave no space between x and a.
– on either side of a colon used for a ratio
Example
1:10

– on either side of a centered dot used for multiplication
Example
W = F · d
Leave no space before and after ⋅. The formula contains three physical quantities: W represents work,
as the product of force (F) and distance (d).

– on either side of a slash used for division
Example
a/b

– after mathematical operators used as adjectives
Example
–2 °C
Leave no space after –.

– after functions when the argument is in parentheses
Example
tan(/4)
Leave no space after tan.

– between an opening parenthesis, bracket, or brace and the next character
Example
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(2x)y
Leave no space between ( and 2.

– between a closing parenthesis, bracket, or brace and the previous character
Example
2(xy)
Leave no space between y and ).

– between back-to-back parentheses, brackets, and braces, e.g., ](
– between nested parentheses, brackets, and braces, e.g., [(

6.3 Font

The overall rule is that symbols representing physical quantities or variables are italic (sloping), but symbols repre-
senting units, or labels, are roman (upright). Please see specific conventions below:

• Use italic type for
– single-letter symbols for variables, physical quantities, and physical constants
Example

∗ V
∗ P

For volume and power.
– superscripts and subscripts that are themselves symbols for variables or physical quantities
Example
CV

For heat capacity at volume V.
• Use roman type for

– multiletter variable symbols, mathematical constants, trigonometric functions, mathematical operators,
numerals, punctuation, and fences
Example

∗ SJW
For Synchronization Jump Width.

∗ BRP
For Baud Rate Prescaler.

∗ π
∗ sin

– superscripts and subscripts that are abbreviations and numbers
Example

∗ Fs
For sampling frequency. F and s are set in roman.

∗ tTq
For time quanta clock cycle. The variable t is set in italic. Tq as abbreviations of time quanta is set
in roman.

∗ r2

The numeral 2 is set in roman.

6.4 Typesetting Formulas

6.4.1 General Typesetting Guidelines

• Use parentheses, brackets, and braces appropriately to avoid ambiguity whenever a fraction is unstacked. Both
stacking of fractions (i.e., separating numerator and denominator by a horizontal line) and unstacking of frac-
tions (i.e., using a slash in place of the horizontal line) are acceptable as long as clarity is not lost.
Example

– stacked: a+ b+c
d + e

– unstacked: a+ [(b+ c)/d] + e
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The expression a+ b+c
d + e, if written as a+ b+ c/d+ e, is ambiguous and could have several interpretations,

such as a+b+c
d+e , or a+ b+ c

d + e. But its meaning is unambiguous if presented as a+ [(b+ c)/d] + e.
• Enclose parentheses within square brackets, and square brackets within braces.

Note: LaTeX uses {} for grouping and defining arguments for macros, while () are treated as ordinary
characters unless specified otherwise. Therefore, in LaTeX, some commands such as the \frac must use
curly braces to enclose its arguments, not parentheses.

Example

E = 1.96 \left\{ \frac{P(1-P)}{m} \right\}^{1/2}

Input the code above in the equation environment in LaTeX, and it will render the formula:
E = 1.96

{
P (1−P )

m

}1/2

.
• In elided lists, commas should come after each term in the list and after the ellipsis points if the list has a final

term.
Example

Preferred Avoid
y = 0, 1, 2,⋯ y = 0, 1, 2⋯
x1, x2,⋯, xn x1, x2,⋯xn

• Use ending punctuation if equations (whether run in with the text or displayed on a separate line) end a sentence.
Example
If a = b, then for all real numbers x, a+ x = b+ x.

• Use the multiplication sign (×), not the letter x to indicate the mathematical operation.
Example

Preferred Avoid
tTq = 2 × tCLK × (2^{13} × BRP.13 + 2^{12} ×
BRP.12 + 2^{11} × BRP.11 +⋯+ 2^1 × BRP.1 +
2^0 × BRP.0 + 1)

tTq = 2 x tCLK x (2^{13} x BRP.13 + 2^{12} x
BRP.12 + 2^{11} x BRP.11 +⋯+ 2^{1} x BRP.1
+ 2^{0} x BRP.0 + 1)

Table 2: How to Type Multiplication Sign
Forms of File Method
.rst Files Install the“Insert Unicode”Extension > press Command + Shift

+ P to open the Command Palette > type Insert Unicode and
select the Insert Unicode: Insert command > type 00d7
(the code for multiplication sign) and press Enter.

.tex Files Insert \times.
Word Files Press Control + Command + Space to open the Character

Viewer > search for “multiplication”in the search bar > click the
multiplication sign ×.

• Do not use an asterisk (∗) to indicate multiplication except in computer language expressions.
Example

Preferred Avoid
x1x2 x1 ∗ x2

• Do not use a centered dot (·) or the multiplication sign × with single-letter scalar variables.
Example

Preferred Avoid
ab a· b and a × b

• Do not use an equal sign as an abbreviation for the word“is”or the word“equals”in narrative text.
Example
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Preferred Avoid
PV = n RT, where P is pressure. PV = n RT, where P = pressure.

6.4.2 Inline Formulas and Interline Formulas

There are two ways to typeset mathematical formulas: inline formulas and interline (display) formulas.
Inline Formulas
Inline Formulas are integrated within a line of text, which is best for simple equations or symbols or when you want
to maintain the flow of text without breaking the paragraph.
In order to fit in with the text, inline formulas appear“cramped”when typesetting large formula elements (fractions,
giant operators, etc).

Fig. 1: Inline Formula Example

Interline Formulas
Interline formulas are set apart from the text and are centered on their own line. They are typically used for more
complex equations or when you want to emphasize a mathematical statement.

Fig. 2: Interline Formula Example

Typesetting Inline Formulas in LaTeX

Inline formulas are enclosed by a pair of dollar signs in LaTeX:

$\textrm{LEDC\_CLK\_DIV} = A + \frac{B}{256}$

As for typesetting inline formulas, please note the following guidelines.
• Do not wrap inline formulas in parenthesis. Parenthesis are typically used to provide additional information

or group related elements. Formulas serve as essential clarification in most cases and therefore should not be
enclosed. If it will add confusion to readers, please rearrange the expression and display it apart from the text.
Example
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Preferred Avoid
For chip revision v0.0, the Audio PLL frequency
is calculated in hardware as follows: fout =
fxtal×(sdm2+4)
2×(odiv+2) .

For chip revision v0.0, the Audio PLL frequency
is calculated in hardware as follows: (fout =
fxtal×(sdm2+4)
2×(odiv+2) ).

• Avoid breaking inline formulas across lines, as it can affect readability. If necessary, rewrite the text or use
display mode.

Typesetting Interline Formulas in LaTeX

Interline formulas are wrapped in an equation environment in LaTeX. It automatically generates a number for the
equation. If you need to present the formula directly without the number, you can wrap the formula in double dollar
signs or \[...\]. See the example below.
With number:

\begin{equation}
f_{\mathrm{out}} = \frac{f_{\mathrm{xtal}} \left(\mathrm{sdm2} + \frac{\mathrm

↪→{sdm1}}{2^8} + \frac{\mathrm{sdm0}}{2^{16}} + 4 \right)}{2 \times (\mathrm{odiv}␣
↪→+ 2)}
\end{equation}

Without number:

\[
f_{\mathrm{out}} = \frac{f_{\mathrm{xtal}} \left(\mathrm{sdm2} + \frac{\mathrm
↪→{sdm1}}{2^8} + \frac{\mathrm{sdm0}}{2^{16}} + 4 \right)}{2 \times (\mathrm{odiv}␣
↪→+ 2)}
\]

The following figure shows the contrast between formula with number and formula without number.

Fig. 3: Contrast Between Formula With Number and Formula Without Number

As for typesetting interline formulas, please note the following guidelines.
• Number formulas consecutively if there are numerous equations or if formulas are referred to after initial

presentation.
• Set numbered equation on a separate line, centered, with parenthetical numbers set flush right.

6.5 Citing Formulas in LaTeX

For cross-referencing interline formulas in LaTeX documents, please follow these guidelines:
1. Wrap interline formulas in an equation environment. This environment automatically generates consecutive

numbers for the equations.
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2. Insert \label in the equation environment. Otherwise, the number generated will be the same if different
formulas are in the same section. It will cause confusion to formula reference. See the example of adding
\label{eq:ledc-clk-float}:

\begin{equation}
\textrm{LEDC\_CLK\_DIV} = A + \frac{B}{256}
\label{eq:ledc-clk-float}

\end{equation}

3. Use the syntax refer to Equation \ref{label} when referring to the equations. For mathematical
expression that does not contain the = symbol, please use Formula (a broader concept) instead of Equation.

4. Add a word or phrase that describes the nature of the equation when making a reference. For example,“From
Equation 1 of LEDC clock”is more helpful than“From Equation 1”.
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Chapter 7

Measurement Units and Abbreviations

This chapter provides guidelines for units of measure and also lists abbreviations and symbols for frequently used
units.

7.1 General Rules for Using Units of Measure

Follow these guidelines:
1. When to abbreviate units and when to spell out units as words

• Abbreviate units when you report a numerical value, e.g.,“The ESP32 Wi-Fi/BT firmware can
only support 40 MHz crystal oscillator for now.”

• Always spell out a unit of measure as a word if a numeral does not precede it, e.g.,“The default
baud rate for ESP8266 is 115200.”

• When starting a sentence with a number and unit, both must be spelled out as words, e.g.,“One
thousand six hundred and eighty-seven kilograms of ground beef were randomly sampled and
tested for E. coli contaminants between August 21 and November 21, 1995.”

Even if a sentence starts with a spelled-out number and unit, use numerals when appropriate in the rest of
the sentence, e.g.,“One thousand six hundred and eighty-seven kilograms of ground beef were randomly
sampled, resulting in 2.5 kg of samples. Then the samples were tested for E. coli contaminants between
August 21 and November 21, 1995.”
You can avoid spelling out number and unit by restructuring a sentence, e.g.,“The ground beef in the
amount of 1687 kg was randomly sampled and tested for E. coli contaminants between August 21 and
November 21, 1995.”

2. When to hyphenate:
• When you use a spelled-out unit of measure in a compound adjective, hyphenate the compound, e.g., 17-inch

display, 3-meter cable.
• When you use an abbreviated unit in a compound adjective, do not hyphenate it; add a space between the

number and the abbreviation. E.g., 20 nA battery, 30 GB capacity.
3. Unless otherwise noted, singular and plural units are abbreviated the same.
• One kilogram and 10 kilograms are abbreviated as 1 kg and 10 kg.

4. Capitalization: With the exception of degrees Celsius, Fahrenheit, and Rankine, units of measure derived from
a proper name are not capitalized when spelled out, but their unit symbols are capitalized. E.g., the unit symbol
for joule is J.

5. Mixing spelled-out units and their abbreviations: Do not mix spelled-out units and their abbreviations in com-
plex units of measure. Either spell out complex units or use their abbreviation (m/s, Bd/s).
Example
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Preferred Avoid
meters per second or m/s m/second
baud per second or Bd/s Baud/s

• Do not mix a spelled-out prefix with an abbreviated unit or an abbreviated prefix with a spelled-out
unit.

Example

Preferred Avoid
kHz kiloHz, khertz

7.2 Prefixes for Units of Measure

Table 1: Prefixes for Units of Measure
Factor Prefix Abbreviation
1024 yotta Y
1021 zetta Z
1018 exa E
1015 peta P
1012 tera T
109 giga G
106 mega M
103 kilo k
102 hecto h
101 deka da
10−1 deci d
10−2 centi c
10−3 milli m
10−6 micro µ
10−9 nano n
10−12 pico p
10−15 femto f
10−18 atto a
10−21 zepto z
10−24 yocto y

7.3 Frequently Used Units of Measure

Table 2: Frequently Used Units of Measure
Factor Prefix Abbreviation
ampere electric current A
ampere-hour electric charge, derivative of coulomb Ah
amperes per meter magnetic field strength A/m
amperes per square meter current density A/m2

baud the speed at which information is sent Bd
bit the most basic unit of information that can be stored in

a computer
bit

bits per second speed of data transmission bit/s
continues on next page
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Chapter 7. Measurement Units and Abbreviations

Table 2 – continued from previous page
Factor Prefix Abbreviation
byte a basic unit for storing computer information, used for

measuring the size of a document. A byte is usually
made of eight bits

B

centimeter length cm
characters per inch letter spacing in typography cpi
characters per second digital data transfer rate cps
coulomb electric charge C
decibel sound intensity dB
degree angular measure °
degree Celsius temperature °C
degree Fahrenheit temperature °F
dots per inch the ability of a computer screen or printer to produce a

clear image/resolution
dpi

exabyte a unit for measuring computer information, equal to
1024 PB

EB

Farad capacitance F
gigabit a unit of information equal to 1024 Mbit Gbit
gigabit per second speed of data transmission Gbps
gigabyte a unit for measuring computer information, equal to

1024 MB
GB

gigahertz a unit for measuring the frequency of sound waves, ra-
dio waves, and computer clock signals, equal to 1000
MHz

GHz

gilbert magnetomotive force Gb
gram mass, weight g
henry inductance H
hertz a unit for measuring the frequency of sound waves, ra-

dio waves, and computer clock signals
Hz

joule energy J
kilobits per second the speed of a modem Kbps
kilobyte a unit for measuring computer information, containing

1024 bytes
KB

kilohertz frequency kHz
kiloohm electric resistance kΩ, kiloohm
kilometer length km
kilowatt power kW
kilowatt-hour energy (usually electric power consumption) kWh
megabit a unit of information equal to 1024 Kbit Mbit
megabits per second speed of data transmission Mbit/s
megabyte a unit for measuring computer information, equal to

1024 KB
MB

megahertz a unit for measuring the frequency of sound waves, ra-
dio waves, and computer clock signals, equal to 1000
kHz

MHz

meter length m
millimeter length mm
million instructions per second computer speed mips
ohm electric resistance Ω
petabyte a unit for measuring computer information, equal to

1024 TB
PB

second a unit of time s
terabyte a unit for measuring computer information, equal to

1024 GB
TB

tesla magnetic flux density T
continues on next page
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Chapter 7. Measurement Units and Abbreviations

Table 2 – continued from previous page
Factor Prefix Abbreviation
volt electric potential difference, electromotive force V
watt power W
watt-hour energy Wh
yottabyte a unit for measuring computer information, equal to

1024 ZB
YB

zettabyte a unit for measuring computer information, equal to
1024 EB

ZB
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Chapter 8

Editing References

Use cross-references to direct users to related information that might add to their understanding of the documentation
content.
Try to write and edit so that you use cross-references only for information that is not essential to the task at hand.
For example, users should not have to look up information to complete a procedure. If your content has too many
cross-references, consider restructuring it.
Unless you have no other choice, do not make cross-references to information that is not within your control, especially
hyperlinks. Websites are always being modified and reorganized, and few things are as frustrating to the user as an
invalid cross-reference.

8.1 Structure and Style of Cross-references

• Information about why a cross-reference might be of interest should precede the cross-reference itself.
Example

– The guidelines for handling numbers in technical context can be found in ChapterNumbers of this manual.
• For cross-references to figures, tables, sections, or chapters in another publication, provide only the title. The

number may be updated without your knowledge.
Example

– See Chapter Overview in ESP32 Datasheet.
• Structure the cross-reference from the most general to the most specific reference.
Example

– For pin layout of ESP32, see ESP32 Datasheet > Chapter Pin Definitions > Section Pin Layout.
• For online cross-references that are formatted as hyperlinks, use descriptive text for the hyperlink; do not use

blank expressions, such as“click here”.
Example

Preferred Avoid
For more information about ESP32, please refer to
ESP32 Datasheet.

For more information about ESP32-C6, click here.

8.2 Formatting of Cross-References

• If the hyperlink comes at the end of a sentence, do not make the ending punctuation part of the hyperlink.
Example

Preferred Avoid
For more information about ESP32, please refer to
ESP32 Datasheet.

For more information about ESP32-S3, click
ESP32-S3 Datasheet.
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Chapter 8. Editing References

• Use color blue and underline to indicate external hyperlinks. Do not rely on color by itself to indicate hyperlink
text. Color-blind users will not be able to see the links.

– In Pages and Word templates, use the Hyperlink character style, which underlines the characters and
applies the color #0096FF (Hex Color #).
Example

– For documents written in markup languages such as reStructuredText and Markdown, follow the existing
style.

– For other types of documents, please refer to their individual template.
• Use color blue, underline, and italics when referring to the title of an article/book in English (see the example

below). For documents written in markup languages such as reStructuredText and Markdown, follow the
existing style.
Example

• The font weight (e.g., light, medium, bold) of a cross-reference does not need to follow that of the sentence in
which it appears.
Example

– Download certificates for Espressif products from Espressif website.
• For cross-references to document, chapter, or section titles, match the capitalization style of the document,

chapter, or section title.

8.3 Cross-References in Chinese Text

• Use book title marks (《⋯》) for Chinese titles of books, articles, newspapers, songs, films, etc.
Example

English Chinese Notes
For more information about ESP32,
please refer to ESP32 Datasheet.

更多关于 ESP32 的信息请参考
《ESP32技术规格书》。

There are no spaces
around Chinese punctua-
tion marks.

• For cross-references to figures, tables, sections, or chapters in another publication, add one space before and
after the title.
Example

– 建议参考《ESP32-PICO-D4技术规格书》 >章节外围设计原理图了解更多信息。
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Chapter 9

Pictures and Diagrams

Pictures and diagrams are vital for modern documentation. They spare you the trouble of reading through long, wordy,
never-ending, intimidating, and monotonous chunks of text. In today’s fast-paced world, a proper illustration or
infographic can save the reader a lot of time, as a visual communicates information not only in a more efficient and
less time-consuming but also in a more attractive and engaging way.
Illustrations bring more air to a document structure and work like magnets impelling the reader to glide through the
preceding text and reach the reward in the form of an engaging illustration. They can be compared to rest areas on a
highway.
Please have a look at the diagram in the following figure. Now imagine how many words the description of the
continuous testing process will require. Still, this textual description will not be as clear and informative as the
diagram.

Fig. 1: Continuous Testing

However, the above arguments do not imply that you should use lots of unnecessary illustrations. On the contrary,
visuals in technical documentation must contain only relevant information to avoid misleading the reader. Every pixel
must be meaningful and insightful.
This chapter starts with the description of terminology and then provides the guidelines for creation and placement
of pictures and diagrams in Espressif’s documentation.
The sections primarily concentrate on illustrations for getting started guides but also touch upon other types of doc-
uments. In any case, most of this information can already be used for the majority of Espressif documents.

9.1 Terminology

For the purpose of disambiguation, this section defines the terms used in this chapter to denote pictorial illustrations
and their parts.

• Image is a picture or diagram intended for placement into a document.
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• Figure is any image included in a document and is usually mentioned or referred to in a surrounding text.
Figures can have numbers and captions. Figures do not include tables.

• Photo is a raw image taken with a camera and stored in memory as a computer file. The term photo may also
denote a computer file itself.

• Picture is a processed photo. It usually contains callouts and other information. It can also include a key.
• Diagram is an illustration drawn manually or generated by a computer program. It usually contains callouts

and a key.
• Caption is the explanatory text that is placed immediately below a figure. It usually consists of one line –a title,

which may also be followed by a paragraph with additional information. This paragraph must have distinctive
formatting to avoid confusion with body text.

• Callout is a label with a leader line that provides textual information about a part of a picture or diagram.
• Key identifies the symbols used in an image and usually appears within an image.

To visualize how the provided terms are related, please check the following figure.

Fig. 2: Terminology Tree

9.2 Taking and Processing Photos

To include a picture of a piece of hardware in a document, you need to obtain professional and consistently looking
photographs. You can turn to Espressif Graphics team to take pictures for you, or you can do it on your own.
The sub-sections below provide general guidelines and best practices for taking photographs to standardize the process.

9.2.1 Taking Photos

Practices to avoid:
• Avoid taking shots with a phone camera from a close distance. It leads to perspective distortions. A tell-tale

sign of this is diverging pin headers on a board, which normally should look parallel to each other.
• Do not take photos on a table lit with standard overhead office lighting. The consequences of that are distracting

background color and texture, as well as dark-gray shadows. The resulting image usually looks amateurish.
• Make sure the board is free from dust and fingerprints, and flux residue.

Practices to follow:
• Use a light tent, a.k.a. a light box. You can buy it or create your own. It only takes a few pieces of paper folded

in a proper way and a couple of lamps.
• Use the resolution of no less than 600 dpi to allow for cutting out closeups in case some minute components

would need to be documented later.
• Choose angles that reveal important components or relevant features of a product. If possible, try to keep to

similar angles across products for consistency of style. Usually, the following angles are required:
– Isometric view (three dimensional view)
– Front view
– Back view
– Side view
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Chapter 9. Pictures and Diagrams

Examples of pictures can be found in ESP32-S2-Kaluga-1 Kit Getting Started Guide.
Once the photos are taken, do the following:

• Obtain the files by copying them from your camera.
• Rename the files in accordance with Section Naming Conventions.
• Archive raw photos in accordance with Section File Storage Locations.

9.2.2 Processing Photos

Now the raw photos need to be processed and reduced in size.
You might also need to cut out closeup views of certain areas of a board from the raw image, for example, some
jumper blocks or resistors.
For this:

• Make background of the photo transparent to avoid issues when inserting this photo into a document with a
non-matching background color.

• Crop unwanted outer areas leaving a small margin or cut out the areas for close-ups.
• Downscale depending on the requirements for your target document. See Section Publishing Checklist.
• Save to PNG with the option transparent background turned on. The PNG format is good for compressing

regular geometrical shapes, text, and straight lines. This is exactly what you can find in pictures of boards,
other hardware, and user interface screenshots.

When the photo is processed, do the following:
• Name it in accordance with Naming Conventions.
• Save to PNG and then:

– If the image needs to be annotated, go to Section Annotating Images. Compressed images requiring
annotations do not need to be archived as they will be stored in source files with annotations.

– If it is a cut-out closeup, archive it in accordance with Section File Storage Locations, then place it into
your target reST file in accordance with Section Placement in a Document.

9.2.3 Annotating Images

Please use LibreOffice Draw for preparing annotated images. Import your compressed photo into LibreOffice Draw
and add callouts. Follow the established style for your type of document.
For development boards’getting started guides, there is a LibreDraw annotated photo template which should con-
siderably simplify the preparation of annotated photos. The template can be found in Documentation Team Site >
Section Something You Might Find Useful > Drawing Templates > template-annotated-photo.odg. Find
how to name, archive, and publish it at the end of Section LibreOffice Draw.

9.3 Preparing Diagrams

This section briefly overviews the tools used at Espressif and then provides the workflow for each tool.

9.3.1 Software Overview

The tools recommended for use are listed below in the highest to lowest priority order:
1. Blockdiag is an extension bundled with Sphinx that allows you to“write”different kinds of diagrams as code

using a simple markup language. Creating diagrams with blockdiag is similar to developing documentation
with Markdown and reStructuredText. This tool is versatile but somewhat limited in its functionality.

2. Draw.io is an online tool for creating all kinds of diagrams. The tool provides more freedom than blockdiag
but has no integration with Sphinx.
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3. LibreOffice Draw is an application from the LibreOffice suite, which provides a lot of freedom in creation of
diagrams.

Blockdiag

A big advantage of diagram generation tools, such as blockdiag suite, is the fact that the diagrams created with them
are essentially computer code. It means that such diagram files occupy much less memory space than pictures and
allow for more transparent version control.
The table below shows all the diagram types supported by blockdiag suite.

Table 1: Diagram Types Supported by Blockdiag
Diagram Type Sphinx Directive
Block diagram .. blockdiag::
Sequence diagram .. seqdiag::
Activity diagram .. actdiag::
Network diagram .. nwdiag::
Rack diagram .. rackdiag::
Packet diagram .. packetdiag::

For diagram preparation, you can use the online interactive shell located at http://interactive.blockdiag.com/ to write
the code and instantly generate your diagram to check the result. Once the code is written, you can do one of the
following:

• If the code consists of a few lines, you can paste it directly into your reST document. The example of such a
code block is given below:

.. blockdiag::
:caption: Some Caption
:align: center

blockdiag example {
A -> B -> C;
B -> D;
}

• If the code consists of multiple lines, you can choose to store the diagram code externally. It will help avoid
cluttering your reST file with different types of code blocks. For this, do the following:

– Save it to a .diag file and name the file in accordance with Section Naming Conventions.
– Place it into your project in accordance with Section File Storage Locations.
– Add a reference in your reST file (see an example of such a reference below):

.. seqdiag:: ../../_static/diagrams/example-seqdiagram.diag
:scale: 90
:caption: Some Caption
:align: center

Note: Apart from blockdiag, there is another useful diagram generation tool –wavedrom.
Wavedrom is an interpreter that can draw a Timing Diagram or Waveform from a simple textual description. To write
the code and instantly generate your diagram, use the online editor located at https://wavedrom.com/editor.html.
Due to some technical reasons, it is not integrated into ESP-IDF’s CI server, but you can export your diagram in
PNG and add to your document.
The workflow for inserting wavedrom diagrams into documents is given below. When a diagram is created, do the
following:

• Name it in accordance with Section Naming Conventions.
• Save to .rst and archive the source file in accordance with Section File Storage Locations.
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• Publish the diagram after choosing the appropriate image format according to Section image_format.
• Place it into your target reST file in accordance with Section Placement in a Document.

Draw.io

https://www.draw.io has an interface similar to an office suite application. This tool allows you to draw all kinds of
diagrams. It is versatile, simple-to-use, and accessible from any computer that has an Internet connection.
When a diagram is created, do the following:

• Name it in accordance with Section Naming Conventions.
• Save to .drawio and archive the source file in accordance with Section File Storage Locations.
• Publish the diagram after choosing the appropriate image format according to Section image_format.
• Place it into your target reST file in accordance with Section Placement in a Document.

LibreOffice Draw

This office application allows creating diagrams and complex illustrations that combine photos and graphics.

Note: Please use LibreOffice Draw only!
Due to limited compatibility between Microsoft Office, WPS Office, and OpenOffice/LibreOffice, editing and re-saving
diagrams in different office suites may irreparably corrupt formatting.

Follow the established style for your type of document.
For development boards’getting started guides, there is a LibreDraw block diagram template that should consid-
erably simplify the preparation of block diagrams. The template can be found in Documentation Team Site > Section
Something You Might Find Useful > Drawing Templates > template-block-diagram.odg.
When you finish creating a diagram, do the following:

• Name it in accordance with Section Naming Conventions.
• Save to ODG and archive the source file in accordance with Section File Storage Locations.
• Publish the diagram after choosing the appropriate image format according to Section image_format.
• Place it into your target reST file in accordance with Section Placement in a Document.

For TRM (technical reference manual) diagrams, there is a LibreDraw TRM diagram template that should help
in preparation of TRM diagrams. The template can be found in Documentation Team Site > Section Something You
Might Find Useful > Drawing Templates > template-trm-diagram.odg.

9.4 Choosing Image Formats

9.4.1 Factors to Consider

The goal of choosing an appropriate image format is to ensure clarity, readability, and usability across various appli-
cations and platforms. You can choose an image format based on but not limited to the following factors.

• Scalability. Choose image formats that maintain better clarity after scaling, providing flexibility for various
scenarios.

• Compatibility. Choose image formats compatible with the target platform and devices to for better display.
• Searchable Text. Choose image formats that allow texts within images to be searchable, enhancing document

usability and accessibility.
• File Size. Select image formats to optimize file size while maintaining image quality.
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9.4.2 Recommended Image Formats

You can follow the recommendations below to choose an appropriate image format.

Images Without Text

• Choose thePNG format for compatibility and scalability. For example, using PNG format images in an HTML
document allows transparent background to blend with readers’webpage style, and provides better clarity due
to lossless compression of PNG.

• JPEG is an alternative to PNG where file size is a concern.

Images with Text

• Use the PDF format wherever possible to enable searchable texts. For example, embedding PDF images in a
PDF document allows readers to find the image as well when searching for key words.

• If PDF format is not supported, consider PNG or JPEG format recommended for images without text.

Note: In situations where texts in an image is unsearchable, do not rely on the text in the image to deliver key
information. You should:

• Provide descriptive texts preceding or following the image itself.
• Make full use of the image caption and the :alt: attribute to provide more information about the image

content.
In this way, users can still locate the image by searching for key words in the caption, alternative information, or text.

9.5 Naming Conventions

Naming conventions need to be adopted for uniformity in names. It will help locate required files effortlessly, sparing
you the need to look through the whole list or to use the search function.
For now, this section mostly deals with names for images in Git repositories. The general approach is as follows:

Fig. 3: Naming Conventions for Image Files

Example

Figures Example
Raw photos esp-wrover-kit-v3-layout-isometric-raw
Source files with annotated photos and pictures ex-
ported from them for publishing

esp-pico-kit-v4.1-layout-front

Cut-out closeups for publishing esp32-devkitc-v2-jp7-usb-5v
Source diagram files and published pictures • esp32-ethernet-kit-block-diagram

• get-started-what-you-need
• spi-slave-miso-dma-wavedrom
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9.6 File Storage Locations

Depending on the documentation development environment, projects can have different locations for storage of source
files and published images.
The table below shows how the storage of image files is organized in some mature projects.

Table 2: Storage Locations for Image Files
Project Project Storage Software File Format Location
TypeName
Git-
lab

esp-idf Raw Photos — Original
format

//idf/figures/

Source Files with
Annotated Photos

LibreOffice Draw .odg

Source Graphics blockdiag .diag //espressif/esp-
idf/docs/_static/
diagramswavedrom .rst

draw.io .drawio //idf/figures/
LibreOffice Draw .odg

Publishing Cut-out
Closeups

.png //espressif/esp-
idf/docs/_static

Published Pictures .png
Published Diagrams .png

La-
TeX

Projects
on
Sharela-
tex

Source Graphics LibreOffice Draw .odg //Source Files/
Source Graphics

Published Graphics LibreOffice Draw,
exported

.eps or

.pdf
//images

If your project does not yet have a workflow for dealing with source graphics and images, please consider following
an existing workflow for the project of your type.

9.7 Publishing Checklist

The pictures and diagrams for Markdown and reStructuredText files should comply with the following requirements:
• The font should be Helvetica or Helvetica Neue. The text in pictures and diagrams must be of the size similar

to the document’s body text. The use of provided templates does not guarantee the appropriate text size as
its scale depends on the dimensions of the resulting image.

Note: After you place an image into a document, make sure that the text in the image is readable without a
magnifying glass or 400% zoom!

• Width of the image should not exceed 800 pixels. If at 800 pixels the text in an image is too small, try splitting
the image into several parts. If splitting is not possible, place a clickable thumbnail and include the phrase
Click to Enlarge in the caption.

• If a picture needs to be placed onto a webpage, the picture should be drawn at the scale of 100%, so that you
have control over the text size of callouts during production.

• Do not add unnecessary white space around images, especially at the top and bottom. Keep in mind that the
same white space will exist between actual diagram and the text above of caption below, if not separately
cropped after exporting.

• Leader line calling out a part of a photo and the dot terminator should be visible against the background.

9.8 Placement in a Document

There are a few intricacies regarding organization and style.
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9.8.1 Positioning

Ideally, pictures should appear immediately after the paragraph in which they were mentioned. Pictures should be
center aligned.

9.8.2 Numbering and Captions

For documents with lots of chapters and sections, consider the following points:
• In most cases, add numbering and captions under a figure.
• The authoring environment permitting, figures and their captions should stick together. For example, if a

caption is carried over to the next page, the figure should also go with the caption to the next page.
• Different types of figures can have separate numbering. For example, there can be Figure 4-5, Register 2-15,

etc.
• If a document consists of multiple chapters in which the number of figures pushes to a few dozens, consider

using double numeration:
[Figure type word] [chapter number]-[sequential number]. Caption Text
Example

– Figure 1-5. Naming Conventions for Image Files
Also, consider adding a list of figures after the table of contents.

Short documents make it easy to locate figures as you read the text. It obviates the need for numbering pictures, but
captions can still be added.

9.8.3 Cross-References to Figures

When providing internal links in documents with lots of chapters and sections, start with a capitalized figure type
word and give only the figure number. There is no need to provide the figure caption. For example, see Figure 4-1,
then check Register 17-3.
Short documents, such as getting started guides, might require adding links to figures for quick navigation. The
established style for reST files is as follows:

• Add a label with a descriptive name immediately before the figure to which you want to refer. The recom-
mended naming pattern for a label is as follows:

– Picture-file-name.
– If the label will also be used to refer to this figure from other documents, use the pattern Short-
ened-doc-name-picture-file-name.

• Place the :ref: role with this label name where you need a link to this figure.
An example of an established style for adding links to a figure in reST documents is given below:

.. figure:: ../../_static/esp32-devkitc-functional-overview.jpg
:align: center
:alt: ESP32-DevKitC V4 with ESP-WROOM-32 module soldered

ESP32-DevKitC V4 with an ESP-WROOM-32 module

For description of components, see :ref:`ESP32-DevKitC V4 board <get-started-esp32-
↪→devkitc-functional-overview>`.
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Chapter 10

Tables

A table is an array of data organized in rows and columns, or, possibly, in a more complex structure. As a commu-
nication tool, a table helps to arrange and present some types of information in a way that otherwise might not be
obvious or readily understood.
Tables fall into a similar category as pictures and diagrams. In contrast to running text, all these tools are for a
more visual representation of data. A table should be designed so that its main points are easy to understand just by
skimming through the table. The text referring to the table may summarize the main points of the table content but
should not repeat the details.
As the design and implementation of tables usually take more time comparing to writing a textual description, start
by planning a table structure that will allow you to present information as clearly and efficiently as possible. It will
help to avoid spending time on multiple iterations later.

10.1 When to Use Tables

Use tables to present information that is easier to read if organized in rows and columns rather than in running text.
There are several specific situations in which tables are routinely used in Espressif documentation as a matter of
custom or formal convention:

• Organize and present repetitive information so it is easier to search and look up specific values, e.g., register
map of microcontroller’s peripherals grouped by the peripheral functionality.

• Provide quick reference instructions or descriptions, e.g., for key components of a development board.
• Provide a way to compare and analyze data applicable to specific conditions, e.g., power consumption of a

device depending on communication throughput.
There are situations where presenting the data in an alternative way may be more effective or appropriate:

• Consider using a graph to compare data if you are more concerned with relationship of the data than absolute
values. But if you need to provide specific values that are difficult to read from a graph, then a table is a better
option.

• If a table would contain a single column, use a list instead.
• If a table would contain two or fewer columns and rows, consider presenting information in a numbered or

bulleted list or in text format.
For extensive tables that take one or more pages to present, consider additional alternatives:

• Splitting large and complex tables into smaller individual tables
This alternative may be useful if the table contains several records grouped into a smaller number of categories,
and you describe the table contents category by category. Consider separating that description into individual
tables instead of providing a single large table at the end.

• Putting extended tables in an appendix
If the table contains supplementary information that is not essential for understanding of presented ideas, it
should be placed at the end of a document.
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• Changing the page layout to landscape to accommodate wide tables
This is a good alternative to reducing the font size if the table does not fit into the page width.

10.2 Elements of a Table

Sample Table 1. Digital Signature Memory Blocks illustrates a simple example of a table with six columns and three
rows. The first row is not counted, because it is only used to display the column names. It is called a header row.
Some columns of a similar category may be grouped and placed under another head above called a spanner head,
such as“Memory Address”in the table below. The heads below the spanner head, as well as all the other heads in
the header row, are called column heads.
Always add a header row to a table, so it is clear what data is presented in each column.

Table 1: Sample Table 1. Digital Signature Memory Blocks
Name Description Size

(byte)
Memory Address Access
Start end

DS_C_MEM Memory block C 1584 0x0000 0x062F WO
DS_X_MEM Memory block X 512 0x0800 0x09FF WO
DS_Z_MEM Memory block Z 512 0x0A00 0x0BFF RO

The left-hand column of a table is called a stub (see the column“Name”in the table above). It usually provides a
vertical listing of data categories in the columns to the right. Add a stub if rows show similar records of data, e.g.,
measurement results, and there is no other way to clearly identify specific record, e.g., to specify the time when the
measurement was taken. In this case, the stub may be in the form of an index column providing a consecutive number
of each measurement.
The stub head may be omitted if the entries below are too unlike or self-explanatory, for example“Symbol”may
be omitted in Sample Table 7. Recommended Operating Conditions.
The stub and the related columns on the left may be formatted differently, if the data is grouped and categorized by
rows. As an example, see Storage Locations for Image Files.
Columns originating from row headings and rows originating from stub entries intersect and create cells.
A column should preferably contain the same kinds of information, for instance, a memory start address appears
in one column, end address in another, and information expressed in words like memory access type in yet another
column. No column should contain identical information in all its cells, place such information in table notes or table
description instead. See below an example of a table with redundant information in column“Connection”.

Table 2: Sample Table 2. ESP32 Ordering Information
Ordering
Code

Core Embedded Flash Connection Pack-
age

ESP32-
D0WDQ6

Dual
core

No embedded flash Wi-Fi b/g/n + Bluetooth® + Blue-
tooth LE

QFN
6*6

ESP32-D0WD Dual
core

No embedded flash Wi-Fi b/g/n + Bluetooth® + Blue-
tooth LE

QFN
5*5

ESP32-D2WD Dual
core

16-Mbit embedded flash (40
MHz)

Wi-Fi b/g/n + Bluetooth® + Blue-
tooth LE

QFN
5*5

ESP32-S0WD Single
core

No embedded flash Wi-Fi b/g/n + Bluetooth® + Blue-
tooth LE

QFN
5*5

In the following table redundant information has been placed in a note below.
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Table 3: Sample Table 3. ESP32 Ordering Information
Ordering CodePage 65, 1 Core Embedded Flash Package
ESP32-D0WDQ6 Dual core No embedded flash QFN 6*6
ESP32-D0WD Dual core No embedded flash QFN 5*5
ESP32-D2WD Dual core 16-Mbit embedded flash (40 MHz) QFN 5*5
ESP32-S0WD Single core No embedded flash QFN 5*5

In some situations, the last row and the last column may be used to provide a total number or summary of data. Such
rows and columns should be made distinguishable by applying different formatting.

10.3 Organizing Information in a Table

The information presented in a table should be easy to scan from left to right and from top to bottom. The following
good practices can help to organize information more efficiently:

• Make table heads descriptive but concise.
• Group columns containing similar data into categories. Provide description for categories in spanner heads

(merged cells). If you then further group categories, for ease of reading, make sure that your spanner head
hierarchy does not exceed two levels.

• Group rows containing similar data into categories. Put the category description in a merged cell and provide
data in rows in the columns to the right.

• Depending on data presented, indicate the measurement units or add some other clarification about the data in
the column. Place this information below the column head in parentheses. For example, in Sample Table 1.
Digital Signature Memory Blocks, it is recommended to put the measurement unit“(byte)”below“Size”if
the table is not in Markdown or reStructureText.

• For narrow columns, where the data fits the column width but there is not enough space for description in the
header, or the provided description is not informative enough, add references to notes below the table.

• When using an abbreviation to fit information in a table cell, make sure its meaning is clear. Provide clarification
in the table notes if required. Use the same abbreviation in the descriptive text when referring to the cell
contents.

• If you need to add notes to table entries, mark the entries using consecutive numbers, letters, or other symbols
like an asterisk (*) in superscript. Use numbers if most or the marked entries are words and use letters if most
of the marked entries are numbers, etc. The reason is that a number or letter in superscript might be mistaken
for an exponent. Place the notes immediately below the table following the text“Notes”, see Sample Table
7. Recommended Operating Conditions. Each note should begin with the character (number, letter or symbol)
used to mark a respective table entry.

Follow consistently all selected conventions for organizing data in a table throughout your document, especially when
presenting a similar type of data or concept.

10.4 Table Style

The table style describes attributes like line thickness, header row shading, alignment of table’s contents in columns,
font size, etc. Use already established style provided in a template for a selected document type. The style may
depend on a presented data type. Use the selected style consistently within a table and for tables throughout your
document. Readers may get confused seeing non-consistent style, and it may take them longer to read and understand
the data. The readers are also likely to misinterpret the same category of data, if it is presented in a different style.
For documents written in markup languages such as reStructuredText and Markdown, simply follow the established
table style.

1 All above chips support Wi-Fi b/g/n + Bluetooth® + Bluetooth LE connection.
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10.4.1 General Recommendations for Style

Below are a couple of recommendations for the table style. Use them if the recommendations are not already covered
in a specific template:

• Make the header row distinct by using bold text or shaded background and headline-style capitalization.
• The default horizontal alignment in table cells is to the left for text and to the right for numbers, except for

cases noted in Sections Alignment of Text in Cells and Alignment of Numbers in Cells.
• In table cells, do not capitalize single-word entries for non-header cells, and capitalize sentence-length entries.

Follow punctuation rules described in Section Punctuation in Lists.
• If a table contains a few rows, keep the table on a single page. In particular, depending on the software used,

do not configure it to break across pages.
• Omit redundant information if it makes easier to analyze the data inside a table. For example, see Sample Table
4. Peripheral Clock Usage—here only the clocks actually used by a specific peripheral are marked as“Y”.
Putting“N”in the rest of the cells will make it harder to look up which peripheral uses which clock.

Table 4: Sample Table 4. Peripheral Clock Usage
Peripheral APB_CLK REF_TICK LEDC_SCLK
TIMG Y Y
I2S Y
UHCI Y
UART Y Y
RMT Y Y Y
LED Y Y

• Use em dash (—) for not applicable data, see Sample Table 7. Recommended Operating Conditions. It is fine
to omit em dash, if the table contains the same kind of data, see Sample Table 4. Peripheral Clock Usage for
example.

• Avoid stretching the table to the page width and making the columns wider than required by the header and
the data inside. On the other hand, if columns contain similar type of data, preferably make them of the same
width, see Sample Table 4. Peripheral Clock Usage as an example.

• Center-align tables on a page (see below).

Table 5: Sample Table 5. 64-bit Timers Base Addresses
Timer Group Bus to Access Peripheral Base Address
TIMG0 PeriBUS1 0x3F41F000

PeriBUS2 0x6001F000
TIMG1 PeriBUS1 0x3F420000

PeriBUS2 0x60020000

• For tables with long rows and multiple columns containing a lot of data, consider using banded rows or columns
(alternate shading) to avoid misplacing data and to improve readability.

10.4.2 Alignment

Alignment of Column Heads

Please use the following recommendations. For illustration, see Sample Table 6. Wi-Fi Reason Code.
• The stub heads (first column) should be left-aligned.
• The column heads (first row) should be left-aligned or centered following the alignment of the column’s cells

(see the sections below).
• If a column is right-aligned, that is normally the case for numbers, then the head should be center-aligned.
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Alignment of Text in Cells

Please use the following recommendations, that apply primarily to horizontal text alignment. See Sample Table 6.
Wi-Fi Reason Code for examples.

• Paragraphs of text should be aligned left like running text.
• Single words should normally be centered, except for stubs.
• Apply center alignment vertically.

Fig. 1: Sample Table 6. Wi-Fi Reason Code

Alignment of Numbers in Cells

Proper alignment of numbers simplifies their comparison and analysis. Values can be aligned to the last significant
digit, to the decimal point, or by using the same units and a fixed number of digits.
Here are specific recommendations:

• Integers are usually aligned to the least significant digit.
• Numbers that include decimal points are usually aligned to the decimal point. If your application does not

support explicit alignment on decimal point, you can usually align the values the right (number of decimal
places is usually the same for the same type of data in a column).

• Column that includes different types of numbers should preferably be aligned according to the most frequently
occurring type, see Sample Table 7. Recommended Operating Conditions.

• Present numbers of the same category preferably in the same measurement units for better readability. If this
is not possible, indicate their respective units, e.g., MHz, Mbps, mA –see Sample Table 7. Recommended
Operating Conditions and Sample Table 8. Current Consumption Depending on RF Modes.

• Number of presented significant digits should be adequate to the range and context of presented values. For ex-
ample, show 68 mA instead of 68.512 mA when providing the average RF power consumption in RX 802.11n,
40 MHz working mode, see Sample Table 8. Current Consumption Depending on RF Modes.

Uncontrollable Alignment

If your application does not support the recommended alignment above, follow the default alignment while keeping
the table format as consistent as the recommended style as possible.

Espressif Systems 67
Submit Document Feedback

Release master

https://www.espressif.com/en/company/documents/documentation_feedback?docId=&sections=&version=Release master%20for 


Chapter 10. Tables

Fig. 2: Sample Table 7. Recommended Operating Conditions

Fig. 3: Sample Table 8. Current Consumption Depending on RF Modes

10.5 Placement in a Document

As tables fall into a similar category as pictures and diagrams, similar rules apply to numbering, captions, positioning in
text, and cross-referencing. For details please see Chapter Pictures and Diagrams > Section Placement in a Document.
There is a couple of additional guidelines that apply to the tables:

• Use the keyword Table instead of Figure in captions.
• Refer to every table from the text.

If a table contains some data for reader’s analysis, the caption should not suggest any interpretation of the data.
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Chapter 11

English Grammar Tips

This chapter touches upon some aspects of English grammar and aims to help you avoid the most frequent mistakes.

11.1 The Indefinite Article (a/an)

Although the incorrect choice between the two forms of the indefinite article (a and an) occurs frequently, the good
news is that this issue can be easily eradicated.
There is a ubiquitous misconception that the choice depends on the letter that follows the indefinite article. In reality,
the choice depends on the sound that comes after the indefinite article!
When you say/write a word that starts with a consonant or a vowel with a consonant sound (e.g., u, eu, o as in one),
you should use the a form of the indefinite article. However, if the first sound of a word is a vowel or a mute h, use
an instead.
Most of the time, picking the right form of article is not hard.
Example

Initial Consonant Sound Initial Vowel Sound
a board an application
a network an example
a status an interface

However, sometimes you should be cautious when picking the right form of the indefinite article.
Example

Initial Consonant Sound Initial Vowel Sound
a hard drive an hourglass cursor [our-glass]
a one-pass compiler [wʌn - pass] an online service
a user [ˈjuːzə(r)] an update

Another tricky area is the use of abbreviations. The choice between the two forms of the indefinite article depends
on how you pronounce the abbreviation.
The table below shows some examples of abbreviations whose pronunciation starts with a consonant.
Example
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A + Abbreviation Pronunciation
A CPU A siː - piː - juː
A PSRAM A piː - ɛs -ram
A PCB A piː -siː- biː
A USB port A juː- ɛs - biː port
A UART interface A juː-ɑː(r)t interface

The following table provides examples of abbreviations with a vowel-sounding initial.
Example

An + Abbreviation Pronunciation
An IoT solution An ʌɪ-əʊ-tiː solution
An RToS An ɑː(r)- tiː- əʊ- ɛs
An MDF device An ɛm - diː - ɛf device
An XML file An ɛks - ɛm - ɛl file
An HDD An eɪtʃ - diː - diː

Those who want to experientially understand why n is sometimes added to the indefinite article should do the following
exercise. Try saying“an application”and then“a application”. Most likely, you will find the pronunciation of
the first option more natural and effortless. The reason is simple: n functions as a liaison giving your tongue a brief
support between the two a sounds.

11.2 On the Usage of the Future Tense

In general, procedures and tasks described in technical documents develop in time continuously. They often tend to
be repetitive or even have a pre-programmed nature.
This means that when you describe procedures and tasks, the present tense should work in most cases.
Example

Preferred Avoid
Upon receiving this event, the event task initializes the
lwIP network interface.

Upon receiving this event, the event task will initialize
the LwIP network interface.

Here is an example of a random RADIUS client. It
uses the password 12345678 to access hostapd.
radius_clients.

Here is an example of a random RADIUS client. It
will use the password 12345678 to access hostapd.
radius_clients.

However, you can add some anticipation by using the future tense to emphasize the following:
• The future result of the reader’s current action
• What should follow if some certain conditions are satisfied or not satisfied

Example
• Run the command printenv MDF_PATH. If the MDF_PATH environment variable has been set correctly,

the command will return the path to the ESP-MDF project directory.

11.3 Misleading Pronouns

Personal pronouns in the third person, such as it (in the singular number) or them (in the plural number), can be
confusing when the words they refer to are not immediately obvious.
In the example below, it is not obvious if the personal pronoun it refers to change rate, or touch reading.
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Example

Correct Incorrect
You need to reset the change rate of a touch reading for
each channel and write the change rate into the file.

You need to reset the change rate of a touch reading
for each channel and write it into the file.

The following example shows an issue with the pronoun them.
Example

Correct Incorrect
Since the submodules on GitHub are represented as links
to other repositories, this command is needed to download
the actual files onto your PC.

Since the submodules on GitHub are represented as
links to other repositories, this command is needed
to get them onto your PC.

Them can refer to submodules as well as to repositories. Of course, you can grasp the meaning from the context, but
the clarity of the sentence will significantly improve if you rewrite it. As submodules represent a set of files, you can
use the synonymous phrase the actual files instead of repeating the same words.
Another suggestion is to avoid using it as an empty subject wherever possible.
Example

Preferred Avoid
If espwifisetmode returns ESPERRWIFINO-
TINIT, then the Wi-Fi driver is not initialized by
espwifi_init successfully.

If espwifisetmode returns ESPERRWIFINO-
TINIT, it means that the Wi-Fi driver is not initialized
by espwifi_init successfully.

Another example shows how a conditional sentence with it as an empty subject can be elegantly turned into a simple
sentence.
Example

Preferred Avoid
The channel field of wifiscanconfig_t set to 0 in-
dicates an all-channel scan mode.

If the channel field of wifiscanconfig_t is set
to 0, it is an all-channel scan.

11.4 Avoid Using Contractions

Avoid using contractions in technical documentation, such as here’s, you’ve, can’t, don’t, it’s.
Please use full words instead.

11.5 Definite Articles Before Proper Nouns

The names of software development platforms, hosting services, and search engines do not require the definite article
before them. These nouns actually belong to the category of proper nouns —names of particular people, places,
companies, services, things, that are always capitalized and are never accompanied by the definite article, e.g., Beijing,
China, etc.
Example

Correct Incorrect
This method is useful if you have a slow connection
to GitHub.

This method is useful if you have a slow connection to
the GitHub.
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Note: There are some exceptions with regard to capitalization:
• Some proper nouns can be capitalized in a different way, like iPhone, which is the decision of Apple Inc.
• Some proper nouns have the definite article accompanying them, like the Hague, The New York Times. In this

case, the definite article is either the part of the name, or there are some historical reasons behind its retention.

However, if a proper noun is a modifier to the following noun, the presence of the definite article is necessary.
Example

Correct Incorrect
Connect the ESP32 board to a PC. Connect ESP32 board to a PC.

Here, the proper noun ESP32 requires the definite article, as it functions as a modifier (or an adjective) specifying
which particular board is to be connected to the PC in question.
Correct example

• The maximum throughput of Bluetooth LE communication between ESP32 boards can reach up to 700 Kbps.
In this case, the proper noun ESP32 does not take the, as it represents a set of objects (ESP32 boards), without
referring to one specific board. As in the previous example, the proper noun ESP32 functions as an adjectival noun.
The difference, however, is that in the previous example“the ESP32”referred to one specific board that was going
to be connected to a PC; hence, the use of the definite article in that case.

11.6 On the Number of Verbs

The number of a verb must agree with the number of the noun or pronoun used with it. Pay attention to special nouns
that can be either singular or plural. When choosing the number of verbs for such nouns, follow the usage conventions
of the word and also take into consideration the specific context.
Note that the word“data”is preferred to be used as a singular noun.
Example

Preferred Avoid
All the data is written and read via CPU directly. All the data are written and read via CPU directly.
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Chapter 12

Avoid Common Chinglish

This chapter summarizes common Chinglish appearing in words and sentence structure. The purpose is to help you
recognize elements of Chinglish in writing and eliminate those elements.

12.1 Unnecessary Words

12.1.1 Unnecessary Nouns

Unnecessary nouns refer to redundant nouns whose sense is already included or implied in some other element of the
sentence.
In Chinglish, the most common type of unnecessary noun is category noun, which announces the category of a
specific noun followed. When such a noun is deleted, the sense is only clarified.
Common category nouns in our documents include work, process, operation, function, procedure and information.
Example

Incorrect Correct Note
Follow the instructions to finish
preparation works.

Follow the instructions to finish
preparations.

“Preparation”falls into the category
of“works”.

It is used in baud rate detection
process.

It is used in baud rate detec-
tion.

“Detection”falls into the category of
“process”.

12.1.2 Unnecessary Verbs

Unnecessary verbs refer to vague and general verbs that do not express specific action. This task is performed by the
nouns that are combined with general verbs.
Common unnecessary verbs are make, have, realize, conduct, accomplish, carry out, adopt, etc. The solution is to
replace unnecessary verb + noun with plain verbs.
Example
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Incorrect Correct Note
The Universal Asynchronous Re-
ceiver/Transmitter (UART) is one such
standard that can realize a flexible
full-duplex data exchange among
different devices.

The Universal Asynchronous Re-
ceiver/Transmitter (UART) is one such
standard that can flexibly exchange
data among different devices in
full-duplex mode.

Realize data exchange =
exchange data.

The process of sending and receiving
data can also be achieved by the CPU
and the DMA.

Data can also be sent and received by
the CPU and the DMA.

1. Process is an unneces-
sary category noun;
2. Achieve sending and re-
ceiving data = send and re-
ceive data.

12.1.3 Unnecessary Modifiers

Adjectives and adverbs in Chinese text are sometimes redundant in English, since their sense is already contained
or implied in the word they modify or in some other element of the sentence. Carrying these modifiers over into
English only results in a duplication.
Example

Incorrect Correct Note
A report from TSR
shows that Espressif has
led the MCU embedded
Wi-Fi chip market in
terms of sales volume
in 2017 and 2018
consecutively.

A report from TSR, a major
marketing research company
located in Japan, showed that
Espressif led the MCU embed-
ded Wi-Fi chip market in terms
of sales volume in 2017 and
2018.

Everyone knows that 2017 and 2018 are two con-
secutive years. The meaning of“consecutively”is
already evident.

The manual encryption,
auto encryption, and
auto decryption oper-
ations share thesame
algorithm, i.e., XTS
algorithm.

The manual encryption, auto
encryption, and auto decryp-
tion operations share XTS al-
gorithm.

The meaning of“same”is contained in“share”
, so “same”can be omitted. However, you can
use“same”to emphasize the fact that all these op-
erations use the same algorithm: The manual en-
cryption, auto encryption, and auto decryption op-
erations share the same algorithm —XTS algo-
rithm.

12.1.4 Saying the Same Thing Twice

In English, sentences repeating the already stated information are considered a waste of reader’s time. Repetition
of ideas appears in our technical documents frequently as mirror-image statements, i.e., the same idea presented first
in positive form, then in negative . The solution is to express the idea from the more important point of view.
Example

Incorrect Correct Note
If input signals remain unchanged for con-
secutive PCNT_FILTER_THRES_Un
APB clock cycles, then they are valid.
Otherwise they are invalid.

Input signals are only
valid if they remain un-
changed for consecutive
PCNT_FILTER_THRES_Un
APB clock cycles.

“Otherwise they are invalid”
does not carry new information.
It is the negative form of the pre-
vious sentence.

This step is required for lengths smaller
than 4096 bits, and not required for
lengths equivalent to 4096 bits.

This step is only required for
lengths smaller than 4096 bits.

“Not required for lengths
equivalent to 4096 bits”presents
the identical picture from the
opposite point of view.
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12.1.5 Repeated References to the Same Thing

In a given sentence or brief passage, after the first mention of an idea, the subsequent references to it can be
shortened . Repeated references add nothing but redundancy.
If the repeatedly mentioned idea is based on a verb, the second reference can be replaced with an expression like“do
so”,“do the same”,“do likewise”, or“do this”.
If the idea is based on a noun, there are four ways of shortening repeated references:

• Eliminating the modifiers
• Replacing the expression with a summary noun
• Replacing the expression with a pronoun
• Replacing the expression with initials (in special cases)

Example

Incorrect Correct Note
[The timer must be disabled (i.e.,
TIMGn_Tx_EN is cleared) before mod-
ifying the 16-bit prescaler.] Modifying
the 16-bit prescaler whilst the timer is
enabled may lead to unpredictable results.

[The timer must be disabled
(i.e., TIMGn_Tx_EN is
cleared) before modifying the
16-bit prescaler.] Otherwise,
the result can be unpredictable.

To avoid repeating all the infor-
mation, we use“otherwise”in
the revised version.

[The I²C bus has two lines, namely a se-
rial data line (SDA) and a serial clock line
(SCL).] Both SDA and SCL lines are open-
drain.

Both lines are open-drain. The repeatedly mentioned idea is
based on a noun.
In the second reference, the SDA
line and the SCL line are re-
placed with a summary noun
“lines”.

Please note that when you translate references from English into Chinese, you’d better not use an equivalent word
like“它”,“这”, but to spell out what the reference stands for.

12.2 Chinglish Collocations

A collocation is two or more words that often go together. Some Chinese words collocate differently from their
English counterparts. When you write a document in English, please do not translate Chinese expressions you have
in mind in a word-for-word manner, but express your ideas using typical English collocations.
For typical English collocations, you can refer to freecollocation.com or search materials on your topic.
Example

Incorrect Correct
Learn knowledge Gain knowledge
Expensive price High price
Passkey interaction Passkey exchange

12.3 Chinglish Sentence Structure

12.3.1 Noun Plague

Unlike Chinese, a language based on vague and abstract nouns, plain English is based on concise and vigorous verbs.
Too many nouns in English are like a plague, and they only make the meaning less clear.
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To deal with a noun that carries necessary meaning, the usual solution is to transform it into a different part of speech:
verb, gerund, adjective, adverb, etc. When the noun construction is so vague that changing part of speech does not
work, you may have to add more words to clarify the meaning.
Example

Incorrect Correct Note
When this bit is set, the Rx DMA
does not flush any frames because
of the unavailability of receive
descriptors or buffers.

When this bit is set, the Rx
DMA does not flush any frames
because receive descriptors or
buffers are not available.

Replace the noun with an adjective:“un-
availability”is replaced with its adjective
form.

When this bit is reset, the MAC
receive state machine is disabled
after the completion of the re-
ception of the current frame.

When this bit is reset, the MAC
receive state machine is dis-
abled after the current frame
has been received.

1. Replace the noun with a verb: “re-
ception”is replaced with“receive”.
2. The meaning of“completion”is ex-
pressed by the present perfect tense.

A special form of the noun plague is using a single noun as an adjective. It is legitimate to use a noun as adjective in
English, e.g., input signal, and pulse width. However, you should not feel free to use any given noun to modify any
other, because the sentence flows more naturally the other way around. The general rule is: no more than two nouns
combined into an adjective.
Example

Incorrect Correct Note
Autobaud
minimum
low pulse
duration
register

Register used to configure
the minimum pulse dura-
tion in the low state during
autobaud detection

The original example in column Incorrect is a register description
excerpted from ESP32-S2 Technical Manual Reference draft.
This noun construction is too condensed. Too produce an under-
standable sentence, the only way is to spell out the meaning.

12.3.2 Placement of Phrases and Dependent Clauses

A phrase is a group of two or more words functioning as a meaningful unit within a sentence or clause.
A clause is a group of words that contains both a subject and a predicate. It is not necessarily a complete sentence.
There are basically two types of clauses: independent clauses and dependent clauses. In this section, we focus on
dependent clauses.
The placement of phrases and dependent clauses within sentences shows readers which idea the writer regards as most
important. When the elements of a sentence are presented in the right order for the desired emphasis, the readers’
attention is directed to the core idea at the end of the sentence. With this impression, readers can smoothly follow
the writer’s line of thought.
When writing a technical document in English, please check the following:

• Short phrases and information should precede long phrases and information.
• Things known to readers should precede things unfamiliar to readers.
• Important information should come at the end of the sentence.

Please note that when organizing your ideas using the above principles, do not break the logical connections between
your ideas.
Example
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Incorrect Correct Note
Removing the second
level of menu from the
Document sidebar on
www.espressif.com is
better.

It is better to remove the
second level of menu from
the Document sidebar on
www.espressif.com.

In this example, the gerund phrase“removing the
second level of menu from the Document sidebar on
www.espressif.com”is far longer than“better”,
so this phrase should be put at the end after gram-
matical adjustment.

The timer must be disabled
(i.e., TIMGn_Tx_EN is
cleared) before modifying
the 16-bit prescaler.

Before
you/software/hardware
modify the 16-bit prescaler,
the timer must be disabled
(i.e., TIMGn_Tx_EN is
cleared).

The main clause“the timer must be disabled”carries
more important information, and should come last.

Espressif (688018) went
listed on the Sci-Tech In-
novation Board (STAR) of
Shanghai Stock Exchange
in July 2019.

In July 2019, Espressif
(688018) was listed on the
Sci-Tech Innovation Board
(STAR) of Shanghai Stock
Exchange.

The date in this case is of secondary importance.
The main point of this sentence is stock exchange
listing.

12.3.3 Dangling Modifiers

Modifiers include participles, gerunds, infinitives, prepositional phrases and adjectives. The rule for modifiers is that
the implied subjective of a modifier must be the same as the subject of the sentence . If the modifier does not
modify the subject of the sentence, it is said to“dangle”.
Example

Incorrect Correct Note
The timer must
be disabled (i.e.,
TIMGn_Tx_EN
is cleared) before
modifying the 16-bit
prescaler.

Before
you/software/hardware
modify the 16-bit
prescaler, the timer
must be disabled.

Spell out the implied subject. In this case, the prescaler can be
modified by“you”(users), software or hardware. You should
check the upper and lower context to confirm the agent of mod-
ification.
The more explicit you are about the subject, the more reader-
friendly this sentence would be.

When updating the
low-speed timer, the
change of settings
should be explicitly
triggered by software.

When you update the
low-speed timer, the
change of settings
should be explicitly
triggered by software.

When the implied subject is not clear, an alternative way is to
use passive voice (less recommended).

It is noteworthy that dangling modifiers are so common that they become more acceptable. Nevertheless, you should
be careful to use them for the sake of your readers.

12.3.4 FANBOYS Conjunctions

In English, words, phrases, and independent clauses are connected using FANBOYS conjunctions, namely for, and,
nor, but, or, yet, and so. In Chinese, however, it is not necessary to add a conjunction after a comma, so Chinese
speakers easily confuse conjunctions with adverbs.
The rule is: whenever you combine two words, phrases and independent clauses with close logical connections, use a
comma plus a FANBOYS conjunction or simply a period in-between.
Example
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Incorrect Correct Note
ESP-IDF has all the
code required to produce
SystemView-compatible
traces, users can configure
necessary project options.

ESP-IDF has all the code re-
quired to produce SystemView-
compatible traces, so users can
configure necessary project op-
tions.

Another approach is to simply put a period in
between:
ESP-IDF has all the code required to pro-
duce SystemView-compatible traces. Users
can configure necessary project options.

That said, FANBOYS conjunctions should not be overused to form super long sentences, since such sentences are
harder to understand.
Example

Incorrect Correct Note
However, PeriBus1 features spec-
ulative read, which means it can-
not guarantee that each read is
valid, therefore, the CPU has to
use PeriBus2 to access some spe-
cial registers, for example, FIFO
registers.

However, PeriBus1 features spec-
ulative read, which means it cannot
guarantee that each read is valid.
Therefore, the CPU has to use
PeriBus2 to access some special
registers, for example, FIFO reg-
isters.

Therefore is an adverb, not a conjunc-
tion, so there should be a period or a
comma plus a conjunction before.
Note that the first sentence is already
long, so we use a period, instead of
adding a conjunction in the revised
version.

The default baud rate of ESP8266
is 74880, therefore, UART tools
that can support the default baud
rate are recommended.

The default baud rate of ESP8266
is 74880, so UART tools that can
support the default baud rate are
recommended.

Replace adverb“therefore”with con-
junction“so”.
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Writing Instructions

This chapter introduces some basic rules about how to refer to UI elements and software and hardware modes in
technical documents.

13.1 UI Elements

A user interface (UI) is a means by which a human interacts with a machine. UI elements are the building blocks of
a user interface which add to the interactivity, allowing users to navigate around the interface and implement various
commands.
When designing instructions and procedures, it is common case that we need to guide readers to interact with UI
elements to complete a specific task. This section summarizes some guidelines on how to describe the interaction
with UI elements in our documentation.

13.1.1 Overview of UI Elements

UI elements usually fall into one of the following four categories:
• Input Components : allow users to input information into the system, such as text boxes, buttons, checkboxes,

dropdown lists, toggles, and radio buttons.
• Navigation Components : help users move around an interface, such as slider, search box, icons, and tags.
• Information Components : share information with users, such as icons, tooltips, progress bar, notifications,

and message boxes.
• Containers : hold related content together, such as kebab menu.

The table below introduces some common UI elements.
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Table 1: Introduction to Common UI Elements
Element (English) Element (Chi-

nese)
Description

Window 窗口 The primary, rectangular area in which application elements are
displayed.

Pane 窗格 A section of a window that provides the user with additional infor-
mation or quick access to features commonly used.

Dialog box 对话框 A pop-up window in which the user provides information or issues
commands.

Toolbar 工具栏 A set of buttons that controls software functions.
Ribbon 功能区 A set of toolbar placed on s everal tabs.
Menu 菜单 A group of the commands, options, etc., of a program arranged by

category.
Tab 标签页 A clickable area in a window that shows another page or area.
Command 命令 A directive to a computer program to perform a specific task in the

form of a label.
Icon 图标 Pictorial representation of a certain element.
Button 按钮 Small area on which the user clicks to execute commands or display

new windows and menus.
Checkbox / check
box

复选框 A yes or no, or on or off, control. When a setting is selected, a
visual indicator appears in the square check box.

Radio button 单选按钮 A control that allows the user to choose only one of a predefined
set of mutually exclusive options.

Toggle 转换键/切换键 A control that enables the user to switch between settings.
Scrollbar 滚动条 A control that moves the view of the data that is displayed in the

window.
Slider 滑动条/滑块 A control that is used to set a value within a range and to give a

visual indication of the setting.
Text field 文本框/输入框 Input area for text.
List box 列表框 A control that allows the user to select one or more items from a

list contained within a static, multiple line text box.
Dropdown list 下拉菜单/下拉列

表
A control, similar to a list box, that allows the user to choose one
value from a list.

The figure below shows some most common UI elements.
Users interact with traditional graphic user interface (GUI) through an input device. For example, a user interacts
with the above interface in Figure with a mouse.
In the meanwhile, as the types of interactive electronic devices have proliferated, users can also interact with a com-
puter or program more naturally through gestures and speech using new types of interfaces known as natural user
interface (NUI). Devices using NUI usually come with touch screens, cameras, sensors, or microphones, which are
commonly integrated in Espressif’s products.

13.1.2 How to Describe UI Elements

Consistent style and text formatting help users locate UI elements and interpret information efficiently. Follow the
guidelines below when referring to UI elements.

General Rules

A UI element normally consists of two parts as shown in the example:
• The element type, such as window, icon, and button.
• The element text shown in the interface.

Espressif Systems 80
Submit Document Feedback

Release master

https://www.espressif.com/en/company/documents/documentation_feedback?docId=&sections=&version=Release master%20for 


Chapter 13. Writing Instructions

Fig. 1: Common UI Elements

Espressif Systems 81
Submit Document Feedback

Release master

https://www.espressif.com/en/company/documents/documentation_feedback?docId=&sections=&version=Release master%20for 


Chapter 13. Writing Instructions

Example

Element Element Type Element Text
Button “Save”

When referring to a UI element, if the meaning is clear enough, then there is no need to specify the element type.
Instead, describe what the user needs to do by referring only to the element text. Do not add the definite article“the”
before the element text.
Example

• Click Save to save the document.
When there is any chance of confusion, and you need to make sure the user begins in the right place, provide a brief
phrase or an introductory step at the beginning of the step by referring to the elements with their proper types. This
will help the user identify the UI elements easier and faster. In such cases, the definite article“the”is needed.
Example

Preferred Avoid Note
On the File menu, click
Open.

On File, click
Open.

Refer to the element type to add clarity when
needed.

For UI elements with no text, clarify its type in the running text and add more specific descriptions. You may choose
one or more solutions from the following list to help readers identify the UI elements:

• Use a similar symbol to represent simple elements or insert a picture showing the element in the running text,
if possible.
Example

– Click the ✚ icon to add more files.
– Click the ⬆  icon to upload.

• Refer to the UI element with the name of the tooltip, if any.
Example

– Click the Help button.

Note: In this example,“Help”is the name of the tooltip which shows when you hover the cursor over the
icon.

• Add a screenshot with the UI element marked out, if necessary.
Do not use the possessive form of UI elements.
Example

Preferred Avoid
On the File menu, click Open. Click the File menu’s Open command.

Capitalization and Punctuation

Write out the UI element text exactly as it appears in the interface, including the capitalization. Do not capitalize the
element type, such as button, menu, and icon.
However, if the element text ends with a period, a colon, an ellipsis, or other punctuation, do not include that end
punctuation in instructions.
Example

Preferred Avoid
Click File > Save As. Click File > Save As⋯.
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Emphasis

Apply special formatting to UI elements for emphasis so that users can identify the elements faster and easier. Stick
to the following rules when referring to UI elements in different formats of documentation.

• In .md or .rst documents:
For UI elements in English or Chinese documents, use backquotes (``) to enclose the UI element text, which
will generate in-line code blocks. Add spaces before and after unless it is followed by punctuation. For more
details about punctuation and when to add spaces, see Chapter Punctuation.
Example

Source Text Rendered Effect

In the Review tab, turn on the
Track Changes toggle.

点击 Deploy按钮后，RainMaker
后端部署过程将启动。

• In LaTeX, Word, or Pages documents:
– For English elements in English document, use boldface for emphasis.
Example

∗ Click Submit.
– For Chinese elements or elements combining Chinese and English in Chinese document, enclose the UI

element text with Chinese double quotation marks.
Example

∗ 点击“提交”。
– For English elements in Chinese document, enclose the UI element text with English double quotation

marks and add spaces before and after unless it is followed by a punctuation mark.
Example

∗ 点击“Submit”。
– For Chinese elements in English document, enclose the UI element text with English double quotation

marks and add spaces before and after unless it is followed by a punctuation mark.
Example

∗ Click“提交”.
For more details about punctuation and when to add spaces, see Chapter Punctuation.

Navigation

When writing procedures that involve navigation through multiple kinds of UI elements, use the simplest description
following the order of the user’s interaction with the interface.
Example

Preferred Avoid Note
In the Start window, on
the Insert tab, click Ta-
ble > Insert Table.

Click the Insert tab in the Start
window, then click Insert Table
under the Table dropdown list.

Readers may be confused if the UI el-
ements do not appear in the right order
as they see in the interface.

Use a greater-than symbol (>) to indicate navigation through UI elements or separate sequential steps. Only use this
approach when there is a clear and obvious path through the UI and the selection method is the same for each step.
For example, do not mix things that require opening, selecting, and choosing. Do not use boldface for greater-than
symbol. Include a space before and after the symbol.
Example
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Preferred Avoid
Go to AWS Console > Services >
CloudFormation.

Go to AWS Console > choose Services > search for
CloudFormation.

Languages

When writing documents that involve UI elements, use the same language for the UI element text and the document,
if possible.
When translating documents that involve UI elements, follow these guidelines:

• If the translation for the UI to the target language is available, use the exact translation in the UI to refer to the
elements.
Example

Source Text Target Text Note
Click Create an AWS Ac-
count.

点击”创建 AWS 账
户”。

The AWS website offers Chinese language
option.

• If you have no access to the translation for the UI to the target language, choose one of the following methods
to refer to the UI elements according to specific requirements on the demand side, if any. Whichever style is
selected, use it consistently.

– Stick to the UI element text in the source text and do not provide translation.
Example

Source Text Target Text
Enter the package name in the Android pack-
age name field.

在 Android package name字段中输
入软件包名称。

– Use the element text in the source text and follow it with your translation in a bracket to add clarity, when
necessary.
Example

Source Text Target Text
Select the checkbox –“Show apps
that create custom IAM roles or re-
source policies”.

勾选复选框——“Show apps that create custom IAM roles
or resource policies”（显示创建自定义 IAM角色或资源
策略的应用程序）。

说出唤醒词”Hi乐鑫”激活开发
板。

Say the wake-up word“Hi乐鑫”(“Hi Espressif”) to activate
the board.

– If the document involves screenshots displaying the interface, refer to the UI elements using the exact
language in the screenshots. Consider following the element text with your translation in a bracket to add
clarity.

Formatting for Voice Commands

Users of an NUI with speech recognition functionality can interact with a program by using voice commands. A
voice command is a structured verbal input from the user that a program will respond to.
When referring to a voice command, enclose the command text in quotation marks. Capitalize the first word in a
voice command. Do not use boldface for the commands. Use punctuation at the end of the command within the
quotation marks only when the voice command is placed at the end of a sentence. Punctuation preceding or within
the command is not necessary unless needed to avoid ambiguity.
Example
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Preferred Avoid
Say the wake-up word“Hi Espressif”to activate the
board.

Say the wake-up word“Hi, Espressif.”to activate the
board.

To activate the device, say“Hi Espressif.” To activate the device, say“Hi Espressif”.

13.1.3 How to Describe Interaction with UI Elements

Use dedicated verbs to describe interaction with UI elements. Note that users interact with interfaces using different
input methods: keyboard, mouse, touch, voice, and more. Therefore, use more generic verbs that work with any
input method when you are not sure which type of input method the user is using.
The table below summarizes some common verbs to describe interaction with UI elements that is applicable to more
than one input method.
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Table 2: Generic Verbs to Describe Interaction with UI Elements
English
Verb

Chinese
Verb

Description Example

Select 勾 选/选
择

To place a checkmark or other indicators in a
checkbox or radio button. • For Alignment, select

Left.
• Select the Yes checkbox.

Clear 清 除/取
消勾选

To remove a mark from a checkbox. It is recom-
mended to use clear rather than deselect.

Clear the Header row checkbox.

Choose 选择 To choose an option, based on the customer’s
preference or desired outcome.

In the font dropdown list, choose
the desired font and click it.

Drag 拖 拽/拖
动

To move an object by sliding the mouse with one
or more buttons pressed or by putting a finger on
the desired point on the touchscreen and slide the
finger.

Drag the Readme file to the Docs
folder.

Release 释 放/松
开

To let up on a keyboard key, a mouse button, or
other physical buttons to initiate an action.

Drag the file and release the mouse
button.

Go to 前往 To navigate to a certain place on the UI. On the ribbon, go to the Insert
tab.

Leave 离开 To leave a website or webpage. Click Submit and leave this page.
Open 打开 To start or activate an application, or to access a

document, file, or folder.
To open the document in the Out-
line view, select View > Out-
line.

Close 关闭 To close a window. Close the document window.
Switch
on/off
& turn
on/off

打 开/关
闭

To turn a toggle key or toggle switch on or off. To track all the changes of the
document, turn on the Track
Changes toggle.

Copy 复制 To place a duplicate of the selection on the clip-
board.

Copy the URL shown below.

Cut 剪切 To remove the selection from the current location
and place it on the clipboard.

Cut the first entry in the list.

Paste 粘贴 To place the clipboard contents at the insertion
point.

Paste your private key into the Key
field.

Enter 输入 To enter or specify information in a field using
physical or on-screen keyboard.

In the search box, enter “Rain-
Maker”.

Zoom
in/out

放 大/缩
小

To enlarge or reduce the size of a window or a
screen.

Zoom in to see more details.

Scroll
up/down

向 上 滚
动/向 下
滚动

To move higher or lower through text or graph-
ics by scrolling the scroll-wheel on the mouse or
sliding the touchpad or the screen.

Scroll down to the bottom of the
page and click Save.

Swipe 滑动 To move quickly in the direction opposite to how
the page scrolls. For example, if the page scrolls
left or right, swipe an item up or down to select
it.

Swipe the page to the right and click
Save.

Collapse 折叠 To click a turner icon (or similar GUI elements)
to hide subentries in the hierarchical structure
you are viewing.

Collapse the ribbon.

Expand 展开 To click a turner icon (or similar GUI elements)
to view subentries in the hierarchical structure
you are viewing.

In the Project window, expand
the Model node.

When the input method of the user is clear enough, use input-specific verbs to clarify, if necessary. The table below
summarizes some common verbs for different input methods.
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Table 3: Verbs to Describe Interaction with UI Elements for Specific Input
Methods

Input
Method

English
Verb

Chi-
nese
Verb

Description Example

Mouse Click/left-
click

点击 To press and release the left mouse button without
moving the cursor to select a link or item on the
screen. Do not use click on or click at.

In the Review tab, click
Previous to jump to
the previous comment.

Right-
click

右击 To press and release the right mouse button with-
out moving the cursor to select a link or item on
the screen.

Right-click the selected
text, and then clickCopy.

Double-
click

双击 To click a mouse button twice without moving the
cursor.

Double-click the file to
open it.

Move 移动 To move the cursor on the workspace by sliding
the mouse with no buttons pressed.

Move the cursor outside
the Mail window.

Drag
and
drop

拖放 To select an object with one or more buttons
pressed, move it by sliding the mouse, and place it
in an alternate area by releasing the mouse button.

Drag and drop the item to
the left column.

Point to 移至 To move the cursor to a specific location on the
screen by moving the mouse with no buttons
pressed.

Point to the Trash icon
and click to open it.

Scroll 滚动 To rotate the wheel button of the mouse. Scroll the wheel button
forward.

Hover
over

悬停 To position the cursor over something without
clicking it.

Hover over the avatar to
see more information.

Touch-
screen

Tap 轻
点/轻
触

To press the screen with a finger or pen tip and
then to lift it, usually quickly.

At the bottom of the
screen, tap Update.

Double-
tap

轻点两
次/轻
触两次

To tap twice in rapid succession. Double-tap the file to
open it.

Long-
press

长按 To press on a certain part of the touchscreen for
several seconds.

Long-press the app icon
and tap Uninstall.

Pinch/stretch缩
小/放
大

To move together two or more fingers on the
screen to zoom in or out.

To decrease the size of the
picture, pinch it.

Key-
board
and
other
physical
buttons

Press 按 To push down on and release a keyboard key or a
physical button.

Press the Reset button.

Press
and
hold

长按 To press down on a physical button for several
seconds.

Press and hold the Home
button.

Type 输入 To press keys on the keyboard to enter informa-
tion in a field.

Type your key ID in the
Key ID field.

Speech Say 说 To speak to a NUI to implement a voice com-
mand.

To wake up the device,
say“Hi Espressif.”

13.2 Software and Hardware Modes

13.2.1 Overview of Hardware and Software Modes

A hardware or software mode is a predefined configuration of multiple components or parameters that helps achieve a
certain desirable state in hardware or software. For example, the working modes of Wi-Fi consist of Station mode, AP
mode, and Station/AP Coexistence mode. Such mode names should be considered as proper nouns. When referring
to hardware and software modes, follow the rules in this document.

Espressif Systems 87
Submit Document Feedback

Release master

https://www.espressif.com/en/company/documents/documentation_feedback?docId=&sections=&version=Release master%20for 


Chapter 13. Writing Instructions

There are also relatively simple hardware or software states frequently referred to in our documents, e.g., half-
duplex/full-duplex or master/slave. These states should not be called“modes”, because such usages devalue the
term“mode”in Espressif documentation.
To avoid overusing the word“mode”, it is recommended to use the following wording when referring to simpler
states:

• The SPI peripheral of the ESP32-S2 can operate as a master or slave.
• It supports full-duplex communication with clock frequency up to 80 MHz.

13.2.2 General Conventions to Refer to Modes

When referring to a hardware or software mode, use title capitalization for the mode name except for the word“mode”
. For hyphenated words in mode names, only capitalize the first word. Do not use the definite article“the”before
mode names.
Example

• Flash encryption should be enabled in Release mode only.
• In Light-sleep mode, digital peripherals of the device are clock-gated.

13.2.3 How to Describe Interaction with Modes

The table below demonstrates the most used verbs in English and Chinese to describe interactions between the device
and different hardware and software modes.

Table 4: The Most Used Verbs to Describe Interaction with Modes
A device can enter/go into a mode.

switch to
support
use/utilize

A device can be in
put into

A device can exit/come out of/leave
wake up from

A mode can be enabled. /
initialized.
disabled.
configured.

设备 支持/具备/具有 模式。
进入/退出
使用/处于
切换至
设置为/配置为
被唤醒。 /

模式被 启用/使能。 /
禁用/停止。
配置/设置。

With regard to the above table, the example sentences are given below.
Example

• When the host connects to ESP32, the tracing module enters Streaming mode.
• The module wakes up from Deep-sleep mode.
• 首先，您需要调用函数，将Wi-Fi配置为 Station模式。
• ESP32支持 Light-sleep和 Deep-sleep两种睡眠节能模式。
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Here are some inappropriate expressions that you should avoid.
Example

Preferred Avoid Note
Flash reads and writes in
STR mode.

Flash reads and writes
under STR mode.

It is recommended to use the preposition“in”.

Configure
pullup/pulldown re-
sistors before the device
enters Light-sleep mode.

Configure
pullup/pulldown
resistors before en-
tering Light-sleep
mode.

In this sentence,“before entering Light-sleep mode”is
a dangling modifier, because its implied subjective (the
device) is different from the subject of the sentence (the
user).

This section only touches upon the most basic rules on how to refer to hardware and software modes. To further
standardize the usage of modes, it is critical to clearly distinguish the“real modes”from“simple states”and to
create an approved reference list of mode names with proper capitalization and hyphenation for all Espressif document
writers and editors.
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Chapter 14

Admonitions

Admonitions are visually distinct elements within documentation that highlight information relevant to the context
while standing out from the main text. Typically marked with icons, borders, or color blocks, they are especially
effective for warnings, tips, notes, and other critical messages that readers should not overlook. Using consistent and
clear admonitions enhances the readability and usability of technical documentation.
This chapter outlines the types of admonitions utilized in Espressif documentation, along with guidelines on their
selection, formatting, and appropriate use.

14.1 Types of Admonitions

Espressif documentation incorporates the following admonition types:
• Tip:

A “Tip”offers helpful advice for doing things better or more easily. Use a tip when you want to offer an
optional piece of information that can enhance the reader’s experience or efficiency but is not essential to
completing the task. Tips may include shortcuts, best practices, or recommended approaches for utilizing a
feature.
Example:

Tip: Configure the board settings in the preferences file to save time.

• Note:
A“Note”provides additional information that is directly relevant to the surrounding text. It is used to clarify
or expand upon a point. Use a note when you want to provide supplementary information that is important but
not critical to the main content. It enriches understanding without hindering the reader’s progress if skipped.
Example:

Note: If you use both filters on the same ADC channel, then only the first one will take effect.

• Important:
An“Important”admonition highlights critical information readers need to know to achieve their goals, such
as prerequisites or steps that must be followed. Use an important admonition when the information is crucial
and must not be overlooked by the reader.
Example:

Important: Enabling flash encryption limits the options for further updates of ESP32-C3. Before using this
feature, read the document and make sure to understand the implications.

• Caution:
A “Caution”advises the reader to proceed with care, indicating a situation where improper action might
lead to unexpected outcomes. Use a caution when there are negative consequences that could result from not
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adhering to the instructions.
Example:

Caution: Any changes or modifications not expressly approved by the party responsible for compliance
could void the user’s authority to operate the equipment.

• Warning:
A“warning”is a strong admonition that alerts the reader to serious dangers or severe consequences that may
arise from specific actions or inactions. Use a warning when the consequences of ignoring the advice could be
severe.
Example:

Warning: On ESP32-S2, when channel’s binded timer selects its maximum duty resolution, the duty
cycle value cannot be set to (2 ** duty_resolution). Otherwise, the internal duty counter in the
hardware will overflow and be messed up.

14.2 Choose the Appropriate Admonition

Selecting the right admonition is essential for conveying the appropriate level of importance and urgency to readers.
Here’s a step-by-step guide to help you select the correct admonition type:

• Step 1: Assess the Importance
Determine the importance of the information relative to the task at hand. Is it essential for understanding or
completing the task, or is it additional, helpful information?

– Essential Information: Use Important, Caution, or Warning if the information is critical.
– Supplementary Information: Use Note or Tip if the information is helpful but not critical.

For example, if certain settings must be configured before running a program, use an Important admonition
to highlight these prerequisites; if using an alternative method can speed up the process, include it in a Tip.

• Step 2: Evaluate Consequences
Consider the potential consequences if the reader ignores the information. Are there risks of errors, safety
issues, legal implications, or other negative outcomes?

– Minor Consequences: Use Note or Tip.
– Moderate Consequences: Use Caution.
– Severe Consequences: Use Warning.

For example, if the information covers minor performance tweaks, add it in a Note; if a certain configuration
might cause slight compatibility issues, place it in a Caution admonition; if failure to follow the instructions
could damage hardware, include it in a Warning.

• Step 3: Match the Tone
Choose an admonition that matches the tone of your document. A formal document might use Caution and
Warning more frequently than a casual blog post.
– Formal Tone: Use Caution and Warning for serious matters.
– Informal Tone: Use Tip or Note for less severe information.

For example, for a product manual, useWarning to alert readers about safety risks with electrical components;
for a blog post, use a Tip to share shortcuts or personal advice.

• Step 4: Consider Urgency
Determine the urgency of the information. Does it require immediate attention, or can it be considered at the
reader’s leisure?

– Urgent Information: Use Warning or Caution.
– Less Urgent Information: Use Important, Note, or Tip.

For example, if incorrect steps could lead to an irreversible system error, use a Warning to stress the urgency;
if the information describes helpful background but isn’t critical, a Note works well.

• Step 5: Determine Information Type
Classify the information you want to convey:

– Advice or Best Practices: Use Tip.
– Additional Context: Use Note.
– Critical Information: Use Important.
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– Potential Risks: Use Caution.
– Serious Dangers: Use Warning.

For example, to encourage the use of shortcuts, include them in a Tip admonition; if a setting’s function is
relevant but not critical, explain it in a Note; if prerequisites must be followed for success, use Important to
highlight them; for steps that might cause minor errors if missed, use Caution; if an incorrect step could lead
to injury, use Warning.

• Step 6: Use Hierarchy
Follow the hierarchy of severity when selecting admonitions:
Tip < Note < Important < Caution < Warning
Start with the least severe and escalate based on the criteria above.

• Step 7: Consider the Audience
Tailor the admonition to your audience. What might be a Tip for an expert could be a Note or even an
Important point for a novice.
For example, if your audience includes beginners, what might be a Tip in advanced documentation could be
an Important for novices.

14.3 Formatting Admonitions

14.3.1 Formatting Admonitions in reStructuredText Documents

In reStructuredText documents, Sphinx provides a set of standard styles for admonitions. You can use the following
syntax:

.. tip::
This is a formatted tip in .rst.

.. note::
This is a formatted note in .rst.

.. important::
This is a formatted important message in .rst.

.. caution::
This is a formatted caution in .rst.

.. warning::
This is a formatted warning in .rst.

Rendering results:

Tip: This is a formatted tip in .rst.

Note: This is a formatted note in .rst.

Important: This is a formatted important message in .rst.

Caution: This is a formatted caution in .rst.

Warning: This is a formatted warning in .rst.
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14.3.2 Formatting Admonitions in LaTeX Documents

In LaTeX, admonitions can be formatted using various packages and custom environments to ensure consistency and
visual appeal.

Choosing the Right Packages

Use the mdframed package to create framed environments for admonitions. It provides precise control over frame
appearance, including colors, borders, and spacing. Also, include the xcolor package to enable the use of custom
colors in the frames.

\usepackage{mdframed}
\usepackage{xcolor}

Defining Custom Colors

In LaTeX documents of Espressif, it is recommended to use the following colors for admonitions.

\definecolor{ForestGreen}{HTML}{2C6B2F}
\definecolor{GoldenDreamColor}{HTML}{1020A0}
\definecolor{DarkOrange}{HTML}{D46B2D}
\definecolor{AllportsColor}{HTML}{A02010}

Defining Translation Commands

For multilingual support, define the translations for admonition titles. Below are the suggested translations used in
LaTeX documents of Espressif.

% Tip
\DeclareTranslation{English}{framedtxttip}{Tip:}
\DeclareTranslation{chinese}{framedtxttip}{提示：}

% Note
\DeclareTranslation{English}{framedtxtnote}{Note:}
\DeclareTranslation{chinese}{framedtxtnote}{说明：}

%Important
\DeclareTranslation{English}{framedtxtimportant}{Important:}
\DeclareTranslation{chinese}{framedtxtimportant}{重要：}

% Caution
\DeclareTranslation{English}{framedtxtcaution}{Caution:}
\DeclareTranslation{chinese}{framedtxtcaution}{警告：}

% Warning
\DeclareTranslation{English}{framedtxtwarning}{Warning:}
\DeclareTranslation{chinese}{framedtxtwarning}{危险：}

Defining Admonition Environments

Add the following definitions to the preamble:

% Tip
\newenvironment{tiplisting}
{\small\mdframed[middlelinewidth=0.5pt, middlelinecolor=ForestGreen,␣
↪→skipabove=15pt]{ \textbf{{\color{ForestGreen} \GetTranslation{framedtxttip}}}}}

(continues on next page)
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(continued from previous page)
{\endmdframed\vspace{12pt}\normalsize}

% Note
\newenvironment{notelisting}
{\small\mdframed[middlelinewidth=0.5pt, middlelinecolor=GoldenDreamColor,␣
↪→skipabove=15pt]{\textbf{{\color{GoldenDreamColor} \GetTranslation{framedtxtnote}}
↪→}}}
{\endmdframed\vspace{12pt}\normalsize}

% Important
\newenvironment{importantlisting}
{\small\mdframed[middlelinewidth=0.5pt, middlelinecolor=DarkOrange, skipabove=15pt]
↪→{\textbf{{\color{DarkOrange} \GetTranslation{framedtxtimportant}}}}}
{\endmdframed\vspace{12pt}\normalsize}

% Caution
\newenvironment{cautionlisting}
{\small\mdframed[middlelinewidth=0.5pt, middlelinecolor=AllportsColor,␣
↪→skipabove=15pt]{\textbf{{\color{AllportsColor} \GetTranslation{framedtxtcaution}}
↪→}}} {\endmdframed\vspace{12pt}\normalsize}

% Warning
\newenvironment{warninglisting}
{\small\mdframed[middlelinewidth=0.5pt, middlelinecolor=AllportsColor,␣
↪→skipabove=15pt]{\textbf{{\color{AllportsColor} \GetTranslation{framedtxtwarning}}
↪→}}}
{\endmdframed\vspace{12pt}\normalsize}

Applying Admonitions in Documents

After defining the environments, use them in the document as follows:

\begin{tiplisting}
\item Configure the board settings in the preferences file to save time.

\end{tiplisting}

\begin{notelisting}
\item Keep the port name handy as you will need it in the next steps.

\end{notelisting}

\begin{importantlisting}
\item Enabling flash encryption limits the options for further updates of ESP32-

↪→C3. Before using this feature, read the document and make sure to understand the␣
↪→implications.
\end{importantlisting}

\begin{cautionlisting}
\item Any changes or modifications not expressly approved by the party␣

↪→responsible for compliance could void the user’s authority to operate the␣
↪→equipment.
\end{cautionlisting}

\begin{warninglisting}
\item The transport should be valid during the client lifetime and is destroyed␣

↪→when esp\_mqtt\_client\_destroy is called.
\end{warninglisting}

Rendering results:
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Fig. 1: Examples of Admonitions in LaTeX

14.4 Usage Guidelines

• Consistency:
– Maintain a uniform style for each admonition type across all documentation, including icons, borders,

colors, and message descriptions.
• Relevance:

– Ensure that each admonition is relevant to the topic at hand.
– Admonitions should provide value to the reader and enhance their understanding or execution of the task.
– Irrelevant or loosely related information should not be elevated to an admonition.

• Placement:
– Position admonitions near related content.
– Do not bury important admonitions at the end of a section or chapter, as they may be overlooked.

• Frequency:
– Use admonitions sparingly to maintain their effectiveness. Avoid overusing“Warning”or“Caution”

admonitions, as this can lead to alert fatigue, where readers start to ignore them.
• Localization:

– Translate admonitions (including both titles and content) while maintaining the same level of severity and
meaning as in the original text.
Below are the Chinese translations for the titles of the five types of admonitions utilized within Espressif
Documentation:

∗ Tip: 提示
∗ Note: 说明
∗ Important: 重要
∗ Caution: 警告
∗ Warning: 危险
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EMoS Quick Reference Guide

The EMoS Quick Reference Guide is intended to provide quick access to basic guidelines in the Espressif Manual of
style. It is available in both English and Chinese. The English version provides guidelines for English documentation,
while the Chinese version focuses on guidelines for Chinese documentation.

15.1 EMoS Quick Reference Guide

Chinese Version

This reference sheet is intended to provide quick access to basic guidelines about writing English documents in the
Espressif Manual of style. For more detailed information and examples, please refer to the full manual.

15.1.1 Active Voice

• When writing manuals and user guides, use active voice and avoid passive voice except for rare instances.
Example

– Press the EN button to reset the system.
• In formal documents, like datasheets or specifications, passive voice can be used more frequently.
Example

– ESP32-S2 is designed for ultra-low-power applications with its multiple low-power modes.
Refer to Section Active vs. Passive Voice for more details.

15.1.2 Point of View

• Write tutorials and how-to guides in second person.
Example

– To program data to the eFuse memory, write the data to the programming register first.
• Write explanations and reference materials from an impersonal point of view.
Example

– The hold function can be used to retain the pin state.
• Avoid using“users”,“the user”or third-person pronouns when you can.
• Avoid switching point of view within a single content type.

Refer to Section Point of View for more details.

15.1.3 Abbreviations and Acronyms

Spell out abbreviations and acronyms on first mention except when they are more familiar than full terms.
Example
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• Mesh development framework (MDF)
• USB

Refer to Section Define Abbreviations and Acronyms at First Use for more details.

15.1.4 Capitalization

• Capitalize the first letter of every word in heading titles, figure and table captions, except for articles, coordi-
nating conjunctions, and prepositions of four letters or less.
Example

– ESP8266 FOTA Demonstration with Phone App
• For hyphenated compounds in heading titles, always capitalize the first word, and capitalize any subsequent

words that are not articles, prepositions, or coordinating conjunctions.
Example

– High-Level Interrupts
• Capitalize the first letter of each item in a list of complete sentences.

Refer to Section Heading Titles for more details.

15.1.5 Punctuation

Use English punctuation in English writing and Chinese punctuation in Chinese writing except for rare cases.

Spaces

• Use spaces between a number and the following unit of measure.
Example

– 40 nm
• Use spaces between an English punctuation mark and the following English word.
Example

– In mixed writing of English and Chinese, use spaces by following rules provided in EMoS.
• Use spaces between Chinese characters and English letters.
Example

– USB接口
• Never use spaces between English ( ),”“,‘‘and the enclosed text.
Example

– (MDF)
• Never use spaces between a number and the percentage sign %.
Example

– 50%
• Never use spaces between a number and the angle sign °.
Example

– 50°
• Never use spaces when specifying a version number of a document or software application.
Example

– v1.1
• Never use spaces around ampersand in abbreviations containing the word“and”.
Example
– R&D

Hyphens/en Dashes

• Use hyphens in a compound modifier preceding the modified word that consists of a noun or adjective and a
present or past participle, or consists of a number, single letter, or fraction and a noun or participle.
Example

– State-of-the-art technology
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– Wi-Fi-enabled toys
– 2-bit data length

• Use en dashes to indicate a range of values, without spaces before and after.
Example

– 2019-2020
• Use en dashes to indicate negative numbers.
Example

– –1

Slashes

Do not use slashes as a substitute for“or”.

Oxford Comma

Use Oxford Comma before the conjunction that joins the last two enumerated items within a sentence.
Example

• The table should provide separate columns for user IDs, their first names, and last names.

Punctuation in Lists

• Use a full stop at the end of each item in a list of complete sentences.
• Do not use punctuations at the end of each item in a list of sentence fragments.

Refer to Chapter Punctuation for more details.

15.1.6 Numbers

• In general, spell out numbers one through nine, and use numerals for numbers 10 and higher. There are many
exceptions when numerals are preferred. Common exceptions include:

– a single-digit whole number used as an adjective
– measurements
– time and dates
– percentages
– parameter values

Example
– 5-year period
– 1 bit
– 8:00
– 5%

• Use a comma“,”to mark off groups of three digits for numbers of five digits or more.
Example

– 10,000
• Write decimals with a period (full stop), not a comma.
Example

– 1.4
• When referring to money, use currency code, instead of currency signs.
Example

– 100 USD
• In general, decimal and hexadecimal numbers are recommended.

Refer to Chapter Numbers for more details.
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15.1.7 Times and Dates

• Use 24-hour system instead of 12-hour system if possible.
Example

– 15:00 Beijing Time
• Use“noon”or“midnight”instead of figures.
• Use ordinal numbers to indicate a date, without st, nd, rd, or th.
Example

– June 4
• Do not use all-numeral style to indicate a date.
Example

– 04/06/2020 NOT acceptable
• When a phrase refers to a month, day and year, set off the year with commas.
Example

– June 1, 2020, was the International Children’s Day.
• When a phrase lists only a month and year, spell out the month and do not separate the month and the year

with commas.
Example

– The new website will launch in December 2024.
• Use three-letter abbreviations without dots for months.
Example

– Jan, Jun, Dec
• Use three-letter abbreviations without dots for days of the week.
Example

– Mon, Thu, Sun
Refer to Chapter Time and Dates for more details.

15.1.8 Measurements

• Use spaces between a number and the following unit of measure.
• Use correct measurements units and their abbreviations. Some frequently used units of measure are:

– Byte, <abbr> B
– kilobyte, <abbr> KB
– kilohertz, <abbr> kHz
– megabit, <abbr> Mbit
– megabits per second, <abbr> Mbit/s
– megahertz, <abbr> MHz

Example
– 85 °C

Refer to Chapter Measurement Units and Abbreviations for more details.

15.1.9 Cross-References

• Use descriptive text for hyperlinks not blank expressions, such as“click here”.
• In LaTeX, Word, or Pages documents, follow the rules below:

– Use color blue (Hex Color #0096FF) and underline to indicate external hyperlinks.
– Use color blue, underline, and italics when referring to English titles of articles, books, etc.

• For .md or .rst documents, follow the existing style.
Refer to Chapter Editing References for more details.

15.1.10 Pictures and Diagrams

• Text in pictures should be of similar size as the document’s body text.
• Place figures immediately after the paragraph in which they were mentioned.
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• Pictures should be center-aligned.
• In most cases, add numbering and captions under a figure.
• Figures and their captions should stick together.

Refer to Chapter Pictures and Diagrams for more details.

15.1.11 Formatting Tables

• Apply center alignment vertically for text in cells.
• The default horizontal alignment in table cells is to the left for text and to the right for numbers, except for rare

cases.
• If a column is right-aligned, that is normally the case for numbers, then the head should be centered.
• Numbers that include decimal points are usually aligned to the decimal point.
• Align the column heads vertically to the bottom.
• Center-align tables on a page.
• Use em dash (—) for not applicable data. It is fine to omit em dash, if the table contains the same kind of data.

Refer to Chapter Tables for more details.

15.1.12 English Grammar Tips

• The indefinite article (a/an) depends on the sound, not the letter, that comes after the indefinite article.
Example

– a USB (starts with /j/)
– an hour (starts with /au/)

• In most cases, use present tense when describing procedures and tasks.
• Avoid using contractions, such as it’s, don’t.

Refer to Chapter English Grammar Tips for more details.

15.1.13 Avoid Common Chinglish

Common Chinglish include:
• Unnecessary category nouns, such as function, work, process
• Unnecessary verbs, such as conduct, make
• Repetition of ideas presented in both positive and negative form
• Chinglish collocations, such as“learn knowledge”
• More than three nouns combined into an adjective
• Adverbs misused as a conjunction

Refer to Chapter Avoid Common Chinglish for more details.

15.1.14 Referring to UI Elements

• Write out the UI element text exactly as it appears in the interface, but do not include the end punctuation if
there is any.

• In .md or .rst documents, use double backquotes (``) to enclose the UI element text.
• In LaTeX, Word, or Pages documents, follow the rules below:

– Use boldface for English elements in English document.
Example

∗ Click Submit.
– Use double quotation marks for UI elements in other cases.
Example

∗ Click“Submit”.
∗ Click“提交”.
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• Use a greater-than symbol (>) to indicate navigation through UI elements and include a space before and after
the symbol.
Example

– In the Start window, on the Insert tab, click Table > Insert Table.
• Use the UI element text in the same language (EN/CN) as the document language if the corresponding language

option is available in the interface. Otherwise, use the source UI element text or follow the text with your
translation in a bracket to add clarity.
Example

– Say the wake-up word“Hi乐鑫”(“Hi Espressif”) to activate the board.
Refer to Section UI Elements for more details.

15.1.15 Referring to Software and Hardware Modes

• In general, use title capitalization for the mode name except for the word“mode”.
• Do not use the definite article“the”before mode names.
Example

– Flash encryption should be enabled in Release mode only.
Refer to Section Software and Hardware Modes for more details.

15.1.16 Technical Terms

• Use technical terms consistently within one document or across all project-specific documents.
• Always consult Espressif Term Base if you are not sure about a certain technical term.

15.2 EMoS快速参考指南

English Version

本指南提供了《乐鑫风格手册》(EMoS)中文文档基本写作规范的快速参考。请参阅完整手册获取更多信
息和示例。

15.2.1 主动语态

• 编写用户手册和指南时，使用主动语态，除特殊情况下，应避免使用被动语态。
示例

– 按下 EN按键使系统复位。
• 在正式文档（如数据表、规格书）中，可以适当使用被动语态。

更多信息，请参考章节Active vs. Passive Voice。

15.2.2 叙述视角

• 在教程和操作指南中，以第二人称称呼读者。
示例

– 对 eFuse存储器的数据进行编程，首先需将数据写入编程寄存器中。
• 在解释性和参考性文档中，从客观的物称视角进行描述。
示例

– Hold功能可用于保持管脚状态。
• 尽量避免以“用户”或第三人称代词称呼读者。
• 相同文档类型中，尽量使用同一叙述视角。

更多信息，请参考章节Point of View。
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15.2.3 缩写和缩略词

• 文档中第一次提到缩写和缩略词时，请使用全称。
示例

– Mesh开发框架 (MDF)
• 如果缩写和缩略词比全称更常见，则可直接使用缩写和缩略词。
示例

– USB
更多信息，请参考章节Define Abbreviations and Acronyms at First Use。

15.2.4 大写

中文文档中，尽量避免在标题或句子开头使用英文单词。若无法避免，无需大写首字母。

示例

• flash加密功能
更多信息，请参考章节Heading Titles。

15.2.5 标点符号

除特殊情况下，英文文档应使用英文标点符号，中文文档应使用中文标点符号。

空格

• 数字和单位之间使用空格。
示例

– 40 nm
• 中文和数字之间使用空格。
示例

– 2020年
• 中文和英文字符之间使用空格。

示例
– USB接口

• 中文标点符号前后没有空格。
示例

– 比如，这个逗号前后没有空格
• 数字和百分比符号%之间没有空格。
示例

– 50%
• 数字和角度符号 °之间没有空格。
示例

– 50°
• 表示版本号 v和数字之间没有空格。
示例

– v1.1

连字符、连接号 (–)

• 连字符可表示数值范围，前后没有空格。
示例

– 2019-2020
• 连接号可表示负数。
示例

– –1
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斜线

不要使用斜线“/”代表“或”。
更多信息，请参考章节Punctuation。

15.2.6 数字

• 五位及以上的数字，由右向左，每三位用英文逗号“,”分隔。
示例

– 10,000
• 小数用句点，不用逗号。
示例

– 1.4
• 表示金额时，建议使用货币代码，不用货币符号。
示例

– 100 USD
• 一般来说，建议使用十进制和十六进制数字。

更多信息，请参考章节Numbers。

15.2.7 时间和日期

表示日期时，不要使用日/月/年或月/日/年全数字形式。
示例

• 不要使用 04/06/2020
更多信息，请参考章节Time and Dates。

15.2.8 度量单位

• 数字和单位之间使用空格。
• 使用正确的度量单位和缩写。常见的有：

– Byte, <abbr> B
– kilobyte, <abbr> KB
– kilohertz, <abbr> kHz
– megabit, <abbr> Mbit
– megabits per second, <abbr> Mbit/s
– megahertz, <abbr> MHz

示例
– 85 °C

更多信息，请参考章节Measurement Units and Abbreviations。

15.2.9 交叉引用

• 添加超链接时，在“显示”文本框中使用具体描述（例如文档名称、网址等），不要使用空泛的描
述（比如“点击这里”）。

• 在 LaTeX、Word或 Pages文档中，请遵循以下规则：
– 外部超链接使用蓝色（Hex Color #0096FF）和下划线。
– 中文书名、文档名、报纸名等应使用蓝色、下划线、书名号。

• 对于 .md或 .rst文档，遵循默认规范即可。

更多信息，请参考章节Editing References。
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15.2.10 图片和表格

• 图片中的文字大小应与正文文字大小一致。
• 图片应紧跟段落之后。
• 图片应居中放置。
• 一般情况下，图片要有编号和标题。
• 图片标题应紧跟图片。

更多信息，请参考章节Pictures and Diagrams。

15.2.11 表格

• 单元格中的文本应垂直居中。
• 除特殊情况外，单元格中的文本应居左对齐，数字应居右对齐。
• 如果某一列居右对齐，说明单元格中为数字，此时该列的表头应居中对齐。
• 表格中有较多小数时，数字应按小数点对齐。
• 表头应垂直居下对齐。
• 表格应在页面中水平居中放置。
• N/A数据可使用破折号 (—)，有时也可省略。

更多信息，请参考章节Tables。

15.2.12 UI元素

• 应使用交互界面中 UI元素的准确原文本，包括大小写字母，但需省略结尾的标点符号。
• 在 .md或 .rst文档中，应在 UI元素文本两边使用反双引号（``）。
• 在 LaTeX、Word或 Pages文档中，遵循以下规则：

– 对于英文文档中的英文 UI元素文本，使用加粗字体。
示例

∗ Click Submit
– 在其他情况下，使用双引号。
示例

∗ 点击“提交”。
∗ 点击“Submit”。

• 使用大于符号 (>)来指示不同 UI元素之间的顺序，符号前后加空格。
示例

– 在“开始”窗口的“插入”标签页，点击“表格”>“插入表格”。
• 如果用户界面中提供了与文档语言相同的语言选项，则应在文档中使用该语言的 UI元素文本。若
无相应语言选项，则直接使用原文本，或使用“原文本（翻译）”的形式。
示例

– 在“Android package name”字段中输入软件包名称。
– 勾选复选框——“Show apps that create custom IAM roles or resource policies”（显示创建自定义

IAM角色或资源策略的应用程序）。
更多信息，请参考章节UI Elements。

15.2.13 硬件/软件模式

一般情况下，模式名称的大写应遵循标题的大写规则。

示例

• 仅可在 Release模式下启用 flash加密。

15.2.14 技术术语

• 使用技术术语时应保持一致。
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• 如不确定某一技术术语，可参考《乐鑫术语库》。
For more detailed information and examples, please refer to the full manual.
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Chapter 16

Resources

This section introduces useful resources and documentation that will help you in terms of document preparation and
review.

16.1 Internal Resources

All the internal resources listed here can be found in Documentation Team Site > Section Something You Might Find
Useful.

• EMoS Training Video
EMoS Training Video is a series of training videos prepared by the Documentation team which introduce the
basic rules of writing provided in EMoS. In these videos, you will learn which rules are applicable to Chinese,
and which are applicable to English by analyzing typical examples we encountered at work. You will also know
the background and reasons behind making these rules, getting convinced to adopt them.

• Espressif Term Base
Espressif Term Base lists technical terms frequently used in Espressif documentation. The terms are provided
in a tabular format both in English and Chinese for easy reference.
Each term has a definition to point out exactly what is understood by the term. Please pay attention to definitions
and avoid interchangeably using terms that have different meanings or are reserved for different purposes.

• Drawing Templates
• Document Templates on Pages and Word
• Templates, Workflows, and Checklists for preparing various kinds of document

16.2 External Resources

• Merriam-Webster’s Collegiate Dictionary
The dictionary by Merriam-Webster is America’s most trusted online dictionary for English word definitions,
meanings, and pronunciation. It is recommended to refer to it or other authorized dictionaries whenever you
have doubt about vocabulary spelling or usage.
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Chapter 17

Disclaimer and Copyright Notice

Information in this document, including URL references, is subject to change without notice.
All third party’s information in this document is provided as is with no warranties to its authenticity and accuracy.
No warranty is provided to this document for its merchantability, non-infringement, fitness for any particular purpose,
nor does any warranty otherwise arising out of any proposal, specification or sample.
All liability, including liability for infringement of any proprietary rights, relating to use of information in this doc-
ument is disclaimed. No licenses express or implied, by estoppel or otherwise, to any intellectual property rights are
granted herein.
The Wi-Fi Alliance Member logo is a trademark of the Wi-Fi Alliance. The Bluetooth logo is a registered trademark
of Bluetooth SIG.
All trade names, trademarks and registered trademarks mentioned in this document are property of their respective
owners, and are hereby acknowledged.
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